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1. User Guide 
Introduction  

This user guide assumes that you are familiar with basic Windows techniques, such as 
using a mouse, manipulating window sizes and positions, scrolling etc.  

From Power-Up  
When the operating system has finished booting, and if prompted by the system, please 
log in.  The default software installation places a shortcut to the OmniTek software on the 
desktop.  The software will have been installed into ‘c:\program files\omnitek\omnitek 
XR’. Consult the software installation guide as required. 

 

By default the OmniTek XR application does not auto-start upon starting windows, so to 
start the application, double click either the ‘OmniTek XR’ icon on the desktop, or select 
‘OmniTek XR’ from the Start menu/Programs/OmniTek. 

 

If required, OmniTek XR can be set to start up automatically with Windows. This can be 
done by selecting ‘Preferences’ from the File menu, and then selecting ‘Start with 
Windows’.  Details on all of the menus in OmniTek XR starts on page 9.

Quick Start Guide  
This section provides a basic guide to setting up the OmniTek application to use 
OmniTek XR.  Since all OmniTek XR systems have the ability to send status messages 
over SNMP, by default the system attempts to connect to an SNMP service that may be 
running on the PC.  If such a service cannot be found, you will see the following 
message. 

 
If you do not need the SNMP functionality, this can be safely ignored.  However it is 
possible to prevent this message appearing again.  To do this, select ‘SNMP Settings…’ 
from the ‘Configuration’ menu.  From the dialogue that appears, clear the tick box labeled 
‘Display error if connect unsuccessful’. 

If you do need the SNMP service, then this needs to be separately installed.  The SNMP 
service is a Microsoft operating system extension, and can be installed from the master 
Windows installation disk created by Microsoft.  OmniTek have a document on the 
support section of our website explaining how this service may be installed.  The 
OmniTek website address is www.omnitek.tv 

Further details on the use of SNMP with OmniTek XR may be found in the SNMP 
appendix, starting on page 68. 

Full Screen 
After installation, XR defaults to running in Full Screen Mode.  Press the ESCape button 
to toggle between normal mode and full screen mode.  Full screen modes have little 
control ability, although different displays may be configured, and keyboard presets can 
be defined for common functionality.  However they have the advantage of normal 
‘windows’ modes of a less cluttered screen.  Typically full screen modes have a black 
background which may make them more suitable in a colorist type of environment. 
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If you don’t want to use full screen mode, you can change the default setting by selecting 
‘Configuration…’ from the ‘Full Screen’ menu.  Clear the tick box marked ‘Startup in full-
screen mode:’, and click OK on the dialogue.   

Details on Full Screen modes are on page 14.   

Video Setup  
Once the system is running normally within ‘Windows, the next thing to do is to set the 
video standard you will be working in.   Normally you will want to use ‘Auto Detect’, which 
may be set on the ‘Video Standard’ toolbar. 

 
If the toolbar is not visible, it may be selected from the ‘Show’ menu.  If you do not wish to 
use Auto Detect, you can select a specific standard from this toolbar.  However you may 
also need to select the lock reference.  This can be done by selecting ‘Engineering…’ 
from the configuration menu, and you then need to select the ‘Video’ section, and then 
the ‘General’ page. 

  
It would be normal to select ‘Serial’ lock for a waveform monitor.  Serial lock is selected 
automatically in ‘Auto detect’. 

For further details of video setup, please refer to page 13 of this manual.   

Windows Layout 
By default, the choice of windows and toolbars that was previously used will open.  If 
these are not suitable, you can change which windows are open, and their positions, by 
using usual click and drag techniques.  A full list of the available windows is on the 
‘Window’ menu, although most windows have icon shortcuts. 
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If you have previously saved a system configuration, you can open a configuration, by 
selecting ‘Open System Configuration’ from the ‘Configuration’ menu.  No system 
configuration files are included with the original installation.  

Image Choice  

 
If you have an OmniTek XR system that also includes the Motion/Capture option, the full 
‘Source’ toolbar will be present.  If it is not visible, it can be turned on from the ‘Show’ 
menu on the main application.  For normal use, you should set the analyser source to be 
the serial input, and you must select whichever of input A of Input B that you have 
connected to.  If you also have the optional Motion and capture package, then you also 
have the option to set this to ‘Generator’, which is the setting to view data that has 
previously been captured.  If you only have OmniTek XR without additional options, this 
toolbar only has the Input A/Input B switch, and the other items are automatically 
selected to monitor whichever link is selected. 

 

Now that the chosen source is active, and the windows are present, you can use your 
OmniTek XR system. Complete details on OmniTek XR operations are contained in the 
next sections.  
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2. Detailed User Guide 
Opening Window Description  

With the OmniTek application running, you will see a window similar to that illustrated 
below, depending on what modules and options are present on your system. 

 
Dealing with each area in turn, and starting with the menus…  

Menus  
Each function on the menus is described in detail.  

File Menu 

 
The file menu has three main functions, Preferences, Window layouts, and snapshots. 
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Preferences 
From the Preferences choice, you can enable automatic resizing of windows when 
changing standards.  This can be useful if you are using the waveform windows at the 
default size for a given standard, as not all standards use the same aspect ratio. 

When the OmniTek application is started, it automatically loads the configuration that was 
active when it was last closed.  The second Preference choice here lets the system 
prompt you for choice of configuration instead.  This can be useful if different people use 
the system, and have different requirements. 

It should be noted that a System configuration contains 100% of your setup data.  It 
includes which windows and toolbars are open, and their sizes and positions, what video 
format, what locking reference, what options have been set for the optional error logging 
package etc.   

The ‘Start with Windows’ menu entry forces OmniTek XR to start up at the same time as 
you log into Windows.  This saves you having to start the application from the desktop, or 
Start menu. 

There are two menu choices for measurement units.  These affect all uses of the related 
measurement units.  For example, by selecting the amplitude measurement units to be 
milli-volts, then amplitude measurements made using the cursors will be in milli-volts, the 
minimum and maximum thresholds will be expressed in milli-volts, and all the waveform 
graticules will be shown in milli-volts.  If the values are expressed as digital levels, this is 
as a 10 bit number from 0 to 1023, which can also be shown in hexadecimal. 

Similarly the horizontal measurement units can be shown as time, in uS, or as pixel 
sample number.  Hence the horizontal axis on the waveform graticules will show a 
different range of sample number depending on the current video format. 

Related to these global settings for measurement units, please note that two separate 
waveform calibrations are available.  These are the SMPTE range of 64 to 940/960, and 
the full range of 0 to 1023.  The setting for this can be changed using the Option menu in 
the waveform window, selecting the Graticule submenu, and then choosing either 
‘SMPTE range’ or ‘Full range’.  Full details on the menus in the waveform window are on 
page 37. 

Windows Layouts, and Snapshots 
It is possible to load and save windows layouts.  These layouts only save the size and 
position, and status of the windows, so engineering settings like video format are 
unchanged. 

Window snapshots let you save the current contents of a window to a file in an 
appropriate format.  If all snapshots are saved, then the contents of every open window 
is saved.  Waveform, histogram and vectorscope windows are saved as bitmap images, 
and the dataview window is saved as a text file.  It is also possible to save individual 
windows, using a menu selection on each window, which is detailed in the Window 
menus section, starting on page 37. 
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Show Menu  

 
The main desktop application has four work surfaces available.  You can just use one.  
However, if preferred, you can split the various windows amongst the four work surfaces, 
which may help to keep an uncluttered screen.  The Show menu gives access to the four 
different pages, although you can also use the four buttons available on the bottom right 
hand side of the status bar (see page 65 for details on status bar).  For each of these four 
work surfaces, you can define which toolbars are present, and which windows are open.  
This is easily done by selecting a given work surface, and once in that surface, 
open/close the windows and toolbars as required.  This will not affect what toolbars and 
windows are open in other windows.  Note that the four buttons on the status bar are only 
correctly available if your screen resolution is set to a minimum of 1280 * 1024.  For 
smaller resolutions, some of the buttons will be off the edge of the display.  We always 
recommend using 1280 * 1024 or larger displays. 

The Show menu also lets you individually enable or disable each toolbar. The available 
toolbars are  

Window  main controls for the OmniTek application. It lets you open/close 
the main operating windows, plus controls a few special purpose 
features. 

Run   transport controls to control sequence playout (only if the 
Motion/Capture option is present)  

Source  displays the main router controls, which select the source for the 
analyser, the source for the monitoring output, and the source for 
the serial output (only if Motion/Capture option is present), and 
for all versions, control the A/B input switch 

Video-Standard  a small toolbar that lets you change video standard without going 
into the main Engineering dialogue 

Region Of Interest This is a separate window that acts in conjunction with the 
waveform and vectorscope windows, and provides fine detailed 
control over which portion of the image is used to create 
waveforms etc.  This is described in detail on page 43. 

Crosshairs   position control and readback of main cursor  

Cursors    measurement cursors for time and amplitude  

Closed Caption Log  This provides access to logging closed caption data to an XML 
file. 

Status bar   at bottom of main window – provides video standard details. 

As a standard ‘Windows’ feature, all toolbars can be moved around on the main toolbar 
region, or can be undocked from this region.  Toolbars can be docked at either the top of 
bottom of the main application window.  It is not possible to dock on the left or right edge. 
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Run Menu  
The Run menu is provided to duplicate the transport controls included on the Run toolbar.  
It is anticipated that the controls will normally be used from the toolbar, as this is usually 
much quicker to use.  However the menu is provided such that automated keyboard 
macros may be used, as menu items can always be selected by combinations of key 
presses. 

Items available on the Run menu are ‘Play’, ‘Stop’, ‘Jog’ etc, and are all described in the 
section on the Run toolbar, on page 27, along with the ‘Time Shift’ feature that is included 
only as part of the ‘Advanced Option Package’. 

 

Configuration Menu  

 
This menu contains four sections.   

System Configuration 
This section lets you load and save entire system configuration settings.  These control 
100% of the machines settings, such that you can copy the system configuration settings 
from one machine to another, and have it set up identically, with the same windows open, 
in the same positions etc.  The current settings are always saved when the application is 
closed, and by default will be loaded again when the application restarts.  The system 
configuration is saved in a .ods file. 

Engineering Configuration 
The Engineering settings comprise the settings made in the Engineering dialogue box, for 
which full details can be found on page 17. 

When Engineering settings are saved and loaded, the layout of the windows and toolbars 
is unaffected.  Engineering settings are stored in a .ode file. 

SNMP Configuration 
The SNMP settings control the SNMP configuration, which are only required as part of 
the logging package.  Consequently details of SNMP configuration, as well as full details 
on the logging functionality, are included in the appendix starting on page 70. 

Look and Feel Configuration 
Look and Feel presets are used to let you copy the user setup from one system to 
another.  The configuration lets you specify that certain display items sue a specific 
colour, and these settings can then be saved and loaded as presets. 
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Analyzer Menu  

 
The Analyzer menu is shown above.  A variety of functions for the main OmniTek XR 
analyzer module are available here.  Functions used most commonly are available from 
icons on the main toolbar, whilst features that are rarely used can only be controlled from 
this menu.  Each menu item is described in turn. 

Input to Analyzer 
Controls whether the main View module looks at the serial input, or at the Generator 
(only if motion/capture option is present).  This control can also be changed from the 
‘Source’ toolbar. 

Interpolator 
This enables the interpolator that controls how the hardware samples and displays the 
incoming data.  Occasionally a clearer result can be obtained by turning the interpolator 
off, but usually it would be left on. 

Low Pass 
This turns on a low pass filter.  The frequency response changes depending on whether 
the current video format is SD or HD. 

TRS Pass 
By default, TRS data is not displayed in the mini-pic, waveform view, or vectorscope.  
This control lets you enable the display of TRS.  The data shown in the dataview will 
always contain any TRS data present on the signal, regardless of the state of this control. 

Closed Caption Source 
Closed caption data from the serial input can be decoded and displayed on the mini-pic, 
or written into an XML log file.   The data source can be from line 21, EIA608, or EIA708.  
Note that in order to display on the mini-pic, this display must be enabled, which is done 
from the ‘Options’ menu of the mini-pic window.  Details on this on page 44. 
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Output Menu 

 
This menu controls features relating to the output video. 

OmniTek XR can display a crosshair on the output.  The crosshair is always centred over 
the sample currently displayed in the dataview.  The crosshair can appear on the 
analogue (monitoring) output, or the serial digital output, or on both outputs. 

XR can detect when the incoming video is out of range, based on the range thresholds 
set up in the Engineering menu (see page 20 for details), and key out any erroneous 
pixels and replace them with a flashing black and white pattern.  This error display can be 
included on the analogue output, the digital output, or both outputs.  The menu selection 
determines which output is used to display the flashing pattern.  Note that range errors 
can also be highlighted onto the YUV waveforms.  The same thresholds are used to 
determine out of range, but the choice of highlighting is set on the Options/Data menu, 
from within the waveform window. 

Similarly, XR can detect when the incoming video (YUV data) is outside of valid RGB 
colour space.  Again out of gamut pixels can be highlighted on either output with the 
flashing pattern.  In the same way, out of gamut pixels can also be shown on the RGB 
waveforms.  Note it is not possible to highlight pixels with range errors and pixels with 
gamut errors simultaneously on the waveforms, as pixels with range errors can only be 
seen when displaying YUV waveforms, and pixels with gamut errors can only be seen 
when displaying RGB waveforms. 

Full Screen Menu 
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As well as operating within a convention ‘window’, OmniTek XR has many display modes 
that can operate within a ‘full-screen’ environment.  This menu is concerned with these 
modes. 

From the initial menu you can directly launch a specific view into full screen mode.  When 
in full screen, press ‘ESCAPE’ to return to the normal view.  Pressing ESCAPE again will 
go directly to full screen, to the view last looked at. 

By selecting ‘Configuration’, you can adjust various settings. 

 
The full screen display includes a global error detection display.  This shows as 
ERRORS, and the display is the logical AND of all of the conditions that are checked in 
the ‘Video status error checking’ section.  This information, as well as a small amount of 
help information, can be displayed at the top and bottom of the full screen displays, by 
clicking the ‘Show Help/Information’ box.  When in the full screen mode, pressing the ‘I’ 
button also toggles display of the help information. 

It is possible to start up the application and directly start in full screen, by selecting in the 
‘Startup in full-screen mode:’ box. 

Instructions for the use of the Layout Builder. 
OmniTek XR contains a full screen layout editor which provides a host of powerful 
features in an easy to use format.  A new screen layout is normally created by taking a 
copy of an existing template layout, then assigning elements such as waveforms, or 
vectors, to each pane in the layout.  The settings for each element can be customized, 
and a hotkey assigned to the final layout.  It is even possible to have individual 
engineering settings for each layout. 

The loaded screen layouts that match your current screen resolution will always be 
shown in the ‘Layouts’ section at the top of the dialogue.  Start by scrolling through this, 
and selecting the required template.  If there is not a template suitable for your 
requirement, these can be created by editing a text .ini file.  Please contact OmniTek to 
see if an alternative template can be supplied, or for help on how to edit the .ini file. 
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Once you have selected a template layout, the window below will show all currently 
existing instances of that template layout.  It is possible that not all templates will have 
been used, so for some, the window will be empty. 

If there are existing instances, they can be edited.  To create a new instance, select the 
‘Add new instance’ button.  A new instance appears, with the window panes unassigned, 
and the whole thing highlighted in dark red, and an individual pane highlighted in a lighter 
red. 

Similarly you can copy an existing instance including all of its settings, in order to produce 
a similar layout, and you can delete instances no longer required. 

To edit a new or existing instance, start by double clicking one pane within the instance, 
or alternatively right click over the pane, and select ‘Change pane type’.  From the popup 
window, select your choice of waveform, vectorscope etc.  Repeat this process for the 
other panes within the instance. 

Initially the new instance will have a default name shown directly above it, of the form 
‘layout 3’.  Double click on this name, and a popup appears that lets you rename the 
instance. 

Assigning Settings 
By default, no specific settings are assigned to the various portions of the full screen 
view.  So when you enter a full screen view, each pane will adopt the current settings of 
the related window within the normal environment.  For example, the waveforms in a 
given full screen view could show YUV.  Go back to the windows environment, and 
change the waveform display to RGB, and then go back into the full screen display.  If no 
settings have been assigned, then the waveforms will now be showed in RGB format. 

However, if, for the given full screen view, the waveforms had been assigned to YUV, 
they would always be YUV, regardless of the setting within the Windows environment. 

To assign settings to a pane, select the pane, and click ‘Assign’ from the ‘Pane settings’ 
section.  Applicable settings include the choice of YUV or RGB, and whether the 
waveforms are shown at normal size, or are stretched to a larger size. 

If at a later stage you wish to change the settings previously assigned, then ‘Load’ the 
pane settings back into the Windows version, change them to suit your requirement, and 
re ‘Assign’ them back. 

Similarly it is possible to entirely ‘Remove’ the pane settings if required. 

As well as assign Pane settings, it is possible to separately assign the Engineering 
settings, the ROI settings, and the Look and Feel settings. 

The Engineering settings includes things like video standard. 

ROI settings includes things like all line versus single line view, which can also be 
configured to look at specific lines.  This is very useful, as three identical views could be 
configured, except that the first view is All line, the second view is only the first active line, 
and the third view could be only the last active line.  With these views assigned to 
separate hotkeys on the keyboard, it is very fast to switch between these different 
settings. 

The Look & Feel settings include things like the colour of the waveforms. 

Be warned that the various assignments can still be in force after switching from a full 
screen view with an assignment.  For example, if F4 switches to a given arrangement of 
panes, but also switches to NTSC, then the whole unit will remain in NTSC until you 
change it back, or select another hotkey that has an Engineering setting assigned to it.  
So really the Engineering settings should either never be assign, or should be assigned 
to every possible hotkey. 

Whilst certain controls can be assigned to different full screen displays, greater versatility 
and greater ease of use can exist by using Presets (see page 66) to control simple 
functions like switching between single line and multi line view. 

Having chosen your full screen format, chosen displays for each pane, and configured 
each pane to suit your requirements, the last thing to do is to assign a hot key to that 
layout.  Right click over the layout image, and select ‘Assign hot key’ from the menu that 
will appear.  When the hot key dialogue appears, press the key or key combination that 
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you wish to use, and press OK (and do not press Enter on the keyboard, as otherwise 
that will be picked as the hotkey assignment).  Note that certain choices are not available, 
as these are already assigned to the OmniTek application, or to the operating system 
environment.  Once a valid hot key has been assigned, it will be indicated above the right 
hand corner of the layout image.   Subsequent presses of the relevant hot key will switch 
LAB directly into full screen mode into the chosen layout.  The list of all assigned hot keys 
appears on the left of this dialogue.  Hot key assignments can also be deleted or 
changed here. 

Window Menu 
This menu lets you select a given window, and bring it to the front of the other windows. 

About Menu  
The About menu shows you what software versions you are running, and shows your 
license key information. You may need some of this information if you are making a 
support call to your dealer.  

The About menu can always be found at the very right hand edge of the menu bar. 

Engineering Controls (part of Configuration menu) 
When using OmniTek XR, perhaps the most important controls are the Engineering 
controls.  From here you determine the entire configuration of the system, in terms of 
what video format to use, video lock reference, etc.  Each section of the Engineering 
menu selection will now be described in detail. 

Engineering - Video - General 
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Reprogram Flash 
At the top of the dialogue box, there is a button called 'Reprogram Flash'. The main video 
processing on OmniTek products is done using a large FPGA. The firmware for this 
FPGA may be changed by downloading a new design to the onboard Flash memory. It 
this way it is possible to improve the video processing remotely. When a new software 
update is installed, the software should automatically detect the presence of new 
firmware, and reprogram the flash.  This button lets you do the process manually.  Note 
that it is necessary to close all OmniTek applications before reprogramming the flash, so 
any grabbed images and sequences should be saved first.  

Once you have pressed this button, you are prompted for the location of the binary file 
that will be used to program the flash. Each software release includes several different 
binary files, and these will always be stored in c:\program files\omnitek\omnitek xr.   The 
correct file to use is ‘alphaflash_cypress.bin’.  Once the file is loaded, the flash will be 
reprogrammed. This operation takes a little over thirty seconds to complete.  

Set Video Standard 
The current video standard is shown in the box. Clicking the drop down arrow, and 
selecting from one of the available choices can change it.  

Sync Type/Position  
If OmniTek XR is to be locked to reference syncs, select either (Analog) Sync (SD), 
(Analog) Sync (HD) or Serial.  SD sync signals are assumed to be bi-level, and HD sync 
signals are assumed to be tri-level.  If OmniTek XR is not going to be locked to external 
syncs, then select Free.  It is perfectly valid to lock to SD syncs whilst working in HD, as 
long as the format has the same update rates.  This is particularly useful if an HD SPG is 
not available, but you need to use analog reference locking. 

If the OmniTek system is used to look at an internally generated pattern using the 
Motion/Capture option, then it is possible to alter the relative position of the output video 
with respect to the lock reference by adjusting the horizontal and vertical offset controls. 

However, if the OmniTek system is being used to look at a live video source, then the H 
and V offset controls should both be left at zero, as no real timing control is possible for a 
live video source.  If OmniTek XR is to be used to analyse incoming video, then we 
recommend that the XR is locked to that incoming serial video.  

 
Monitoring Output  

OmniTek XR provides an analog non-broadcast grade monitoring output, on a 9-way mini 
din socket. The unit will be supplied with a breakout cable, which will either connect this 
socket to an SVGA connector, or to 5 BNCs, depending on configuration at the time of 
purchase. The video on this connector may be set to RGB or YPbPr, depending on the 
Monitor Mode setting. Please note that if the monitor output is connected to an SVGA 
monitor, then it will be necessary to use the RGB setting. Also note that in some 
standards, there will be HD video on this connector, which will probably exceed the 
bandwidth of cheap SVGA monitors. When the standard is set to NTSC or PAL, it is 
possible to select Composite and Pedestal options for the monitor output. With the 
standard BNC cable, the composite signal will be on the green BNC connector. In this 
mode, there is also an S-Video output. The luma channel is on the red BNC, and the 
chroma channel is on the blue BNC.  

The green BNC will have tri-level sync on it.  

Note that the analog output will run at the frame rate chosen for the video standard.  It is 
possible that some analog monitors will not be able to lock to some of the frame rates 
that are available, in particular the very low rates used by the HDSL formats. 

Engineering - Video – Generator 
This page of the dialogue box is only available if the OmniTek XR system includes the 
Motion/Capture option. 
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The controls relate only to video generated in the Motion/Capture module. 

Power on Defaults 

‘Power on Defaults’ is used to force the analogue and serial outputs from the OmniTek 
XR to a chosen video format, within half of one second from power up of the system, and 
therefore before the operating system has had time to load.  The settings will remain in 
force until the OmniTek XR application has initialized, when the program settings will 
overwrite the power up settings.  To use this feature, just click the button, and the current 
settings will be written into the reprogrammable hardware on the OmniTek card. 

Panning 

By selecting enable, and a speed from 1 to 31, it is possible to have the image/sequence 
continually scroll sideways.  Reverse lets you change direction.  If you keep ‘enable’ 
selected, and drop the speed to 0, the image will stop scrolling, and remain at its current 
position.  To return the image to the normal position, clear the ‘enable’ box. 

Please note that one side of the image will drop one line during panning, since the image 
in effect, wraps around from the right hand edge onto the start of the next line, on the left 
hand edge.  

Blanking and Ancillary Data Playout 

Under 'Use blanking and ancillary data', select 'from internal generator', to have the audio, 
video index, wide screen signalling facilities in XR available to insert data onto the output, 
and remove the entire ancillary data packets from the original source material.  This is 
described in more detail on page 58.  Note that this is only available if the Advanced 
option is present.  If this option is not included, then the blanking and ancillary data can 
only be generated from the internal generator. 
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Engineering - Video - Analyzer 

 
OmniTek XR always works with actual video data, which as a 10 bit value will be a 
number from 0 to 1023.  Sometimes it is easier to understand the operation of OmniTek 
XR if these ranges are scaled to more familiar units.  By choosing ‘Preferences’ from the 
File menu of the main application, you will see some options to change the ‘Amplitude 
measurement units’ from digital levels to Percent IRE, or to Millivolts.  You can also 
specify the decimal or hexadecimal base when looking at digital levels.  The setting on 
the File menu will affect all of the video values shown on this dialogue. 

OmniTek XR detects and count luma/chroma range errors.  The exact levels that trigger 
an error are determined in this dialogue. For range checking, you can specify the 
minimum and maximum IN RANGE values for luma and each chroma component. 
Values less than the minimum, or greater than the maximum will be treated as an error.  
It is possible to detect values within the specified ranges, or outside the ranges, by 
clicking the ‘YPbPr Polarity outside’ box.  Many companies set the minimum value for 
luma and chroma to 0%, which equates to 64 as a digital video level.  The maximum 
values would normally be set to 100%, which equates to 940 digital video levels for luma, 
and 960 for the two chroma components. 

Similarly, XR detects and counts gamut errors, which are calculated by converting the 
data into RGB colourspace, and then noting if any pixels are outside the RGB colour 
cube.  Many companies set the minimum gamut value to be -5%, and the maximum to be 
+105%. 

An error mask is also provided. This is used to remove the top and bottom lines, and the 
pixels near the edges, from the error checking process. This is intended to handle video 
where the edges near the sync are corrupted. The mask has no other effect on the data, 
which will still be grabbed, displayed on the waveform views etc, in their entirety.  

The mask settings are symmetrical, ie however many lines are specified here, then this 
number of active lines will be masked out, on both fields, at both the top and bottom of 
the image. Similarly, the number of pixels entered will effect both picture edges, starting 
from the end active pixel in each case.  
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The settings for luma, chroma or gamut ranges and the error mask may be saved in a 
profile. Click the save range settings button, and the settings will be saved to a named 
profile.  When OmniTek XR is started, the last used profile is automatically loaded. 
However, a new profile may be loaded at any time.  

As well as detecting errors, this dialogue provides access to a special mode of operation 
for the vectorscope, the “luma qualified vectorscope”.  By using this control, the only 
pixels that are used to create the vectorscope are those whose luma lies within the range 
specified for the luma error range checking.  This implies it is not possible to use both 
features at the same time.  

However, you can use the luma qualified vectorscope to, for example, only display the 
vectors for pixels that are nearly black, which can be very useful for colourists.  

It is possible to define a ‘Preset’ to enter and exit luma qualified vectorscope mode, which 
makes this very easy to use.  See page 66 for details on defining presets. 

Engineering - Video – Dual Link (Option) 
If your XR system includes the Dual Link option, there will be an additional page on the 
Video section, to control Dual Link specific settings. 

 

Since there are two coax cables for dual link, you can set the system to lock off either 
input, and you can similarly choose to decode ancillary data from either input. 

If your dual link signal is in YUV format, the data values are not processed.  However, if 
you are using RGB data, the values can be processed in a lookup table.  The linear 
setting leaves data unchanged.  The Logarithmic setting applies a standard log lookup 
table to the data.  Finally, selecting Custom uses your own lookup table.  This needs to 
be loaded in using the ‘Browse’ button, but once it has been loaded, you can switch 
between it and the other settings without having to reload.  Custom lookup tables should 
be in CSV (comma separated variable) format. LUTs are included with OmniTek XR for 
Sony SR, and Thomson Viper cameras, and of course these can be modified to create 
complete custom LUTs.  The supplied LUTs are located in program files\omnitek\omnitek 
xr.    
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Finally, a variable level of gamma correction maybe applied to the video. 

Note that whilst the lookup table adjusts how the waveforms and vectorscope are 
displayed, the data shown in the Dataview window is always the exact data contained 
upon the serial inputs. 

If your Dual Link system also includes the optional Motion/capture module, then you can 
also produce a dual link output from the system.  The output can be configured as either 
single link or dual link.  If dual link, then the output can be selected as either YUV or 
RGB.  If you do not have the motion/capture option, then only a single link, YUV format, 
output is available, regardless of whether the input is dual link or single link. 

 

Engineering – Audio – Error Detection 
OmniTek XR has audio peak and silence detection features, which are configured here. 

 
The levels for the peak and silence detector may each be adjusted.  Both alarms are only 
triggered after a set period of time has elapsed.  This time interval may be entered in 
seconds or in frames.  These settings are stored as part of an overall system 
configuration file, and are also saved when the application is closed. 

The levels, and the timeout are relevant to the display of audio errors in the audio status 
box, as well as being used as part of the logging module, and for the SNMP module, both 
of which are standard with all XR systems. 

Note that in conjunction with the Motion/Capture module, XR can generate video test 
images and sequences.  However XR has no specific audio generation facilities. 
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Engineering – Picture  

 
OmniTek XR can detect whether the picture is moving or frozen, or whether the picture 
has gone to black, or to black and white.  The settings for the detectors may be 
configured here. 

• Motion Content 
A level of filtering can be applied to the picture.  This is designed to accommodate an analog 
VTR that is parked on a single frame.  The picture will be frozen, but the varying analog noise 
from the VTR will mean that each frame is actually slightly different.  The filter setting 
removes a certain amount of noise, and the filtered image is then tested  
The filtering is actually based on an equivalent noise level.  Thus if you have a uniform 
image, and add -36dB of noise to it, then setting this value to -36dB means that the detector 
is on the threshold of noting the image as moving, or not.  Following on from this, a setting of 
-6dB will filter out high levels of noise, and a setting of -54dB will only filter out a very tiny 
amount of noise. 

• Luma Content 
This control works in exactly the same way as the Motion Content control, and detects if the 
picture is black. 

• Chroma Content 
This control works in exactly the same way as the Motion Content control, and detects if the 
picture is black and white. 
 
The results of these detectors are displayed in the Video Status window, described from page 
48 of this manual.  These same detectors may also be used in the logging, or SNMP alerts, 
described on page 68. 
 
 
 

Engineering  - Timecode Reader Configuration 
All OmniTek XR systems include a VITC and ATC reader. 
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ATC is available in SD and HD, but VITC is only read in SD, and it is necessary to 
configure which lines are to be used to read the timecode data.  The typical lines used for 
PAL and NTSC are shown above. 

For ATC, noting that ATC is simply a packet that can contain different types of timecode, 
it is necessary to specify whether you intend to read LTC, VITC1 or VITC2.  Note that the 
term LTC here refers to LTC data embedded within an ATC packet, not to the older form 
of LTC transmitted in an analog format. 

 
Engineering - Video Index Reader Configuration 

OmniTek XR includes a Video Index reader. 

Video Index can only be read in SD. 
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Engineering - Wide Screen Signalling (Line 23) Reader Configuration 
The standard OmniTek XR system can detect and decode wide screen signaling data 
that is contained in line 23 of a PAL/625 signal. 

 

XR can interpret the data either as per EN300294, or as modified by ARDSPEC. 
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Engineering - Teletext Detector Configuration 
OmniTek XR can detect the presence of teletext data in the incoming video.  

 
It is necessary to specify the correct line number that contains the data.   

This feature only works in SD. 
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3 Toolbar Icons 
 

 
Beneath the menus there is a row of icons, referred to collectively as the toolbars, which 
provide direct access to many of the functions contained in the menus. The toolbars 
shown here is just one arrangement with all of the toolbars activated. Of course, 
Windows provides the ability to undock or move each toolbar individually, so they may be 
positioned differently.  

Run (Transport) Toolbar (with Motion/Capture option) 

 

 
Time Shift 

The first two icons are concerned with the Time Shift feature, which is only active if the 
Advance Option Package is present. Time Shift provides the ability to trigger a video 
capture only if a specified error condition occurs.  Captured video can then be reviewed 
or stored to disk for later view.   

  Enter Time Shift mode and wait for a trigger 

 Configure Time Shift mode.  This brings up the Time Shift dialogue box, which is shown 
below. 
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A Time Shift recording can be triggered by one of the trigger conditions shown in this 
dialogue box.  It can be based on reaching one of several given VITC or ATC timecode 
values, or on a specific error condition, such as a CRC error occurring. 

In all cases, it is possible to remain in Time Shift mode, waiting for the next trigger, anc 
continuing until the RAM is full, or to capture a specific number of triggered events, or to 
only capture once, then ask the user whether to continue. 

Since data is always being captured into a circular buffer, after a trigger it is possible to 
retrieve frames prior to the trigger event.  In this way, the grabbed clip can be arranged 
with the trigger frame at the start, middle, or end of the clip. 

Frames can be captured with only the active video being stored, or with the entire video 
raster also being stored, by selecting the ‘Record Full Frames’ control. 

Sequence play controls 

  Jump to start of the Clip/Sequence 

  Move back in the clip by one frame 

  Play the clip backwards. Note that this reverses the order of the frames, but not the fields. 

  Stop playing the sequence 

  Play the clip forwards 

  Move forwards in the clip by one frame 
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  Jump to the end of the clip 

  Enable loop mode for sequence play 

 

The Frame box with drop down selection lets you select an individual frame from the 
sequence for immediate display.  

The speed box with drop down selection lets you choose a playback speed for the 
sequence. This can be real time, quarter speed, half speed or double speed.  

The Record Frames box is where you specify how many frames will be captured during a 
Time Shift capture.  This is a duplicate of the control on the Time Shift configuration 
dialogue. 

Source Toolbar 

 

OmniTek XR has two different Source toolbars.  The above toolbar is active for the basic 
product, and applies to single link sources.  The block diagram indicates major functional 
blocks in XR. 

 
 

The Source toolbar is used to select whether input A or input B is active, and to select 
whether the OmniTek XR Analyzer module is directly looked at the serial input, or the 
output of optional Motion/Capture module.  Similarly, the analogue monitor output can be 
set to reflect what the analyzer is seeing on the serial input, or can look at the 
motion/capture module.  The serial output can be configured in the same way. 

Source Toolbar (Dual Link Option) 

 
This version of the Source toolbar replaces the original toolbar when a Dual Link video 
format is selected.  This is only accessible if the Dual Link option is included on the 
system.  When you switch back only the Video Standard toolbar to a single link source, 
the standard Source toolbar reappears. 

Input B 

Input A 

A/B  
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Capture 

Source 
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 XR Analyzer 

• Waveforms 
• Audio Status 
• Video Status 
• Data View 
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Serial Output 
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A 

B 

Analogue 
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When operating in dual link modes, the source to the analyzer module, the monitor output 
and the serial outputs all must be the same, so all either look at the internal test pattern 
generator (or Frame-store), or they all look at the serial input. 

 

 
 

In Dual link, there are two modes of operations.  It can either operate in full dual link, or it 
is possible to select the ‘Single-link’ button, and then switch between using Link A or Link 
B as the input.  This mode exists for ease of switching between single and dual link 
formats.  However if you are using single link for extended periods, it is recommended to 
switch to a single link video format on the Video Standard toolbar, as in this mode there is 
a slightly extended functionality. 

Whilst in Dual Link, and assuming the Motion/Capture option is also included, the source 
to the waveform monitor can be selected between the internal pattern/sequence 
generator (Frame-store option), and Serial input. 

 

Main Toolbar  

 
The main toolbar contains controls to open the various windows used by the application, 
plus quick access to some commonly required functions. 

 The first icon opens the Generator control window, and is only present with the 
Motion/Capture option. 
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The red ‘triangle’ icon is used to open the Capture dialogue, to capture from the single or 
(optional) dual link input. 

The icon to the left of the red triangle icon is used to load an image or sequence 
previously saved.   

Full details of the controls within this window start on page 53 of this manual. 

  The next icon opens the mini-pic window, where you can see a representation of the 
incoming video, or captured sequence.  This is particularly useful with video formats with 
a particularly low frame rate, which cannot normally be display on conventional HD 
monitors. 

  This icon opens the waveform window.  The waveforms will be displayed in the form set 
using the extended control surface within the waveform window, which is independent of 
the actual format of the incoming video.  The waveform window has menus to configure 
how the window contents are displayed.  This is detailed on page 45. 

 This icon opens the histogram window, which permits detailed analysis of colour gamut 
information.  See page 40 for details of the histogram window. 

  Enable/Disable the Vectorscope.  The Vectorscope can be used independently of the 
waveform mode. 

Like the waveform window, the vectorscope window contains menus to let you configure 
the display. 

 Enable/Disable the data view. This is a window containing sample number, and the data 
values of that sample number, on the current line, plus samples earlier and later in that 
same line. The sample and line numbers are determined by the position of the main 
cursor, which may be changed by clicking in the mini-pic or trace windows, or by using 
the fine control buttons on the toolbar.  The total number of pixel pairs being displayed is 
determined from the Options menu of the dataview window.  The value can be adjusted 
from 1 to 512 samples. The dataview window is scrollable, so you can check video data 
over a large portion of a video line without moving the cursor. 

The data shown will be the actual data on the serial inputs.  With the optional Dual Link 
upgrade, column headings are displayed which reflect the data format set in the 
Engineering menu.  Dual Link data can be RGB or YUV.  
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The data view window will display six columns of data when set into dual link mode, or 
three columns when in single link mode. 

The contents of the Data View window may be saved as a .txt file.  (See the section on 
window menus on page 45).   The file will include all the data within the scrollable 
window, so if the window is set to contain 100 samples, then these 100 samples will be 
saved in that txt file.  The data will be stored in the file in whichever base they were being 
displayed in. I.e. the file will contain decimal, hexadecimal or binary values as selected 
for the window.  

The contents of the data view window are colour coded. In all cases, the text remains 
white, but the background colour changes to show the nature of the data.  

Green indicates pixel is within active video  

Blue indicates pixel is within a TRS packet  

Purple indicates pixel is within an ANC packet  

Light grey indicates pixel is within horizontal blanking  

Black indicates pixel is within vertical blanking for field 2  

Dark grey indicates pixel is within vertical blanking for field 2  

Red indicates a data range error (i.e. video data outside the range that has been set on 
the Engineering menu).  With Dual Link products, there is no guarantee that this range is 
valid for the actual data type on the serial inputs.  Hence it is important to ensure that the 
data ranges expressed on the Engineering menu reflect the type of data you are 
expecting. 

Like other windows, the data displayed can be configured from the drop down menus 
contained within the window. 

  Enable/Disable the video status window. This window lets you view the status on various 
video parameters, and provides controls to enable counters for various error conditions.  
For example, you can count the number of CRC or ANC errors from a given time.  

For each given error type, you can display the errors in the following formats. 

Display the word ERROR on a red background. 

Display a continuous count of the number of errors since the last reset.  

Display an error rate in errors per second. 

Display the time since the last error or since the error count was last reset, as 
appropriate.  

In all modes, the background colour indicates if errors have been detected, with red 
indicating an error. 

The contents of the Video Status window are described in the section on OmniView 
Video Checking Features, starting on page 48. 

 Enable/Disable the audio status window. This window displays information about the 
current audio status, and also contains the PPM meters.   The PPM meters can display 
audio levels from two of the four available audio groups.  The choice of which two audio 
groups is made from the Analyzer menu.  The graticule can be changed using the menus 
on the window.  Refer to page 48 for details. 

 This icon opens the logging window.  The window shows a live display of data that can 
be logged.  This is fully described in Appendix A2, together with other related material. 

  Open the cage generator (safe area/title) dialogue box.  For a full description of this, 
please refer to page 46 in this manual.  

 This button opens or closes the ‘Region of Interest’ control window, which is described on 
page 43. 
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  This button opens a drop down menu that lets you switch between single line view, multi 
line view, and sweep mode.  This control duplicates the drop down at the top of the 
Region-Of-Interest window, described on page 43. 

 Open the Engineering menu – which is described in full starting on page 17. 

  

Crosshair Toolbar  
Next to these controls, we have the controls for the main cursor position.  

 
These show the sample number and line number that the cursor is positioned over. Using 
the mouse, you can click in the mini-pic to position the cursor, and then use these boxes 
to make fine adjustments. For interlaced standards, you can switch fields using the ‘1’ 
and ‘2’ boxes. For progressive standards, these buttons have no meaning, and are 
grayed out.  

You can also use the sample number box to view horizontal blanking. Select horizontal 
magnification, and then increment the sample number such that the sample is outside of 
active video.  The trace windows will scroll to show that sample position in the blanking 
area. This will let you view audio or ancillary data that may be present, if the ‘TRS Pass’ 
selection is on – see the Analyzer menu. 

The 'top' and 'bottom' buttons position the cursor on the top active line, or bottom active 
line of the field/frame.  

The 'left' and 'right' position the cursor on the first or last active pixel of the current line.  

The crosshair can appear on the outputs by selecting from the drop down menu.  This 
can be selected as either the analog (monitoring) output, the serial output, or both 
outputs. 

Cursor Toolbar  
Below these, we have the measurement toolbar.  

 
This lets you enable either time measurement, or amplitude measurement cursors. For 
each cursor type, two cursors may be placed in the trace windows, and moved about to 
take measurements. Time values are displayed in microseconds, whilst amplitude values 
are a relative difference between the two cursor positions.  

Click in the cursor 1 or cursor 2 box, to let you control which cursor you are affecting 
when subsequently clicking in a trace window. The active cursor appears as a solid line, 
whilst the other cursor becomes dotted. The colour of these cursors is determined in the 
Options/Cursors menu selection in the waveform window.  

To move the cursors as a pair, lock the cursors together by checking the ‘Track’ box.  

Please note that it is not possible to control the main cursor by just clicking a new position 
in the mini-pic, when either of the time or amplitude measurement cursors are active. The 
cursor function box must be set back to None, to regain mouse control of the main 
cursor. However, it is always possible to move the main cursor by editing the pixel and 
line values in the crosshair position toolbar.  

Video Standard Toolbar  
This small toolbar only has one function, which is to change the video standard.   
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There are two versions of this toolbar.  The above version is present in a basic XR 
system, whilst the version shown below is present if the option Dual Link module is 
present. 

 
Using the drop down menu is identical to selecting the video format from the Video 
section of the Engineering dialogue’. The video lock reference is unchanged.  If the ‘Auto 
detect’ button is pressed, then the video lock will automatically switch to ‘serial lock’.  If 
auto detect is subsequently cancelled, the unit will remain in serial lock. 

For dual link systems, clicking the ‘Dual-link’ button forces the auto detect circuit to 
assume it has found a dual link input based on whatever format it finds on Link A or Link 
B. The drop down menu is also extended.  All the single link formats are listed as for the 
regular XR system, but underneath these is the complete list of supported Dual Link 
formats, including the 2K formats. 

Note that clicking on the ‘Dual-link’ button only changes the action of the Auto detect 
circuit.  It does not of itself cause the unit to switch into, or out of, dual link mode.  You 
must look at the video standard specified in the drop down box to see if you are currently 
running in a single or dual video format. 
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4 XR Windows 
Waveform Window 

OmniTek XR has extremely powerful and flexible waveform displays.  The necessarily 
means that there are more controls over waveform display than in conventional products.  
This section describes the full set of waveform controls that are included as part of the 
waveform window. 

The waveform window can operate in one of two distinct modes, depending on whether 
the complex set of controls for the window are visible of hidden. 

 
The view above shows these additional controls being hidden, but highlights where to 
click to reveal the window controls.  The more commonly used controls are also 
accessible from the ‘Colour Mode’ menu, on the waveform window. 

If you click in the highlighted section (and grow the window so that you can see all of the 
details), you see the following window. 
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Clicking in the highlighted area this time will hide the waveform display controls, and 
revert to the previous window. 

There now follows a description of the waveform display controls. 

OmniTek XR can operate the waveforms in a variety of different fundamental modes, 
which are selected from the ‘Colour mode:’ drop down control.  These are – 

YCbCr     in the original format as per the serial input 

YCbCr (SD)   displayed on graticules that match regular SD data 

YCbCr + composite As YCbCr but also showing a composite display created 
from the component data 

YCbCr + composite (SD) As YCbCr (SD) but also showing a composite display 
created from the component data 

Y + RGB Shows luma plus the RGB component data 

RGB Standard RGB display 

RGB + composite RGB display also incorporating the same composite 
display from the other modes 

Composite Only shows the composite waveform 

Bowtie Shows a standard Bowtie display 

In all modes, selector boxes appear for each item included in the waveform display, so 
that items not required need not be shown.  The remaining items automatically stretch to 
fill the space when an item is removed.  The waveforms can all be display as full width, 
with each different component stacked vertically, or in a standard parade form. 

The vertical position of the waveform can be adjusted in conjunction with the vertical 
magnification control, to zoom in on particular portions of the waveform.  However this 
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can be done far more easily by right click and dragging over a portion of the mini-pic 
display.  The chosen area is highlighted on the mini-pic. 

 
The section of the mini-pic marked out is used for waveform generation, so you get 
waveforms zoomed into that area.  To revert to the normal display, you must double click 
with the right mouse key, over any portion of the mini-pic display.  Note that when the 
area is marked on the mini-pic, the vectorscope also only displays vectors based on 
information in this area. 

Note also that the technique of marking out an area on the mini-pic also works in exactly 
the same way whilst in full screen modes. 

You can also adjust the sliders on the waveform window controls, or enter specific 
numbers in the numeric entry boxes.  For magnification, boxes are available to select 
various standard levels of magnification. 

If the magnification is used, the ‘Waveform preview:’ section shows which section of the 
video is being used for waveform generation. 

The ‘Look & Feel’ controls can be used to fine tune the gain, gamma curve and decay of 
the waveform traces.  However these are automatically adjust to suit variable levels of 
gain etc, so these controls are not normally used. 

Other controls to affect the waveforms can be found from the three drop down menus in 
the waveform window. 

Options Menu 

 
From the options menu, you can adjust a few specifics of how the waveform traces are 
displayed.   

For RGB type displays, the components can optionally be re-ordered into the GBR order. 
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The graticule lines can be displayed or hidden, and the graticule text labels can also be 
displayed or hidden.  Amplitude markers may also be overlaid onto the main graticules.  
These are horizontal lines that can be used to mark out important levels.  It is possible to 
define multiple markers, and change which is displayed, or to display several at a time. 

Note that the units for both axis of the graticules are customizable, using the global 
selection on the File/Preferences menu selection.  See page 10 for details.  As an 
example, this can switch between decimal or hexadecimal values, or into a mV scale. 

Lastly graticule calibration can be based around the standard SMPTE range of 64 to 
940/960 (expressed as decimal, in 10 bit format), or alternatively around the full range of 
0 to 1023 (again decimal, 10 bit).  Full range video formats are particularly useful in Dual 
Link when using RGB signals.  For example, Thomson Viper cameras generate RGB in 
the range 0 to 1023.  Other cameras generate RGB in the range 0 to 940, so having the 
variable calibration means the waveform monitor can be correctly set to suit. 

The visibility of the crosshair can be toggles.  The crosshair appears as a cursor at a 
given horizontal position on the waveform.  If several components are displayed in the 
waveform, then the cursor appears in the same place on each component.  The position 
of the cursor can be changed by clicking within the waveform. 

Active tooltips causes a small box to follow the mouse pointer providing the X and Y co-
ordinates of the point under the pointer. 

The ‘Look and feel’ menu selection opens a dialogue box that permits customization of 
colours of various items. 
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The Look and feel dialogue can be opened from the Options menu on each of the 
Waveform, Vectorscope, Histogram or Mini-pic windows.  The default page that is active 
is chosen depending on which window you opened it from. 

For the waveforms, the colour of the graticule, and of each different waveform element 
can be individually chosen.  When the waveforms breach the thresholds for valid video, 
(specified in the Engineering dialogue, details on page 20), the waveforms can be 
coloured in a different colour.  Again these ‘error’ colours can be specified uniquely for 
each different waveform type. 

The CRT emulation applies a special filter to the trace data to emulate the look that is 
typical of analogue CRT based waveform monitors. 

The cursor selection lets you change the colour of the measurement cursors, which can 
be used to measure time or amplitude between two points.  The measurements are done 
using the cursor toolbar, which is described on page 33.  Similarly the crosshair colour is 
configurable. 

All of the look and feel choices here will directly affect the waveforms displayed within the 
Windows environment.  They will also affect all waveforms included in full screen screen 
mode, unless specific look and feel settings have been assigned to chosen full screen 
modes.  To find details on assigning, and unassigning look and feel settings to full screen 
modes, please see page 16. 

As the last menu choice, ‘Save snapshot...’ takes the currently displayed waveform 
image, and writes it to disk as a bitmap file.  The user is prompted to enter a filename 
during the save operation. 
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Colour Mode menu 

 
This lists the different forms of waveform display that exist. This duplicates the Colour 
Mode section on the waveform additional controls section, described above.  The 
controls are duplicated for user convenience.  Note that although you can select each 
mode from the menu, you will still need to access the controls within the window to 
change from parade to vertical format, or to select specific components for display. 

Window menu 

 
The window menu lets you directly enter Full Screen mode displaying waveforms.  Press 
the ESCape button to return to normal windows display, or to subsequently re-enter Full 
Screen mode, 

The ‘Resize to fit’ option changes both the waveform display, and how the waveforms are 
generated.  The video processing hardware can generate waveforms in one of four 
resolutions.  At the highest resolution, a single LSB (out of 10 bits) will cause a viewable 
change in the waveform.  This provides the best possible quality to see maximum detail.  
However in some applications, a lower resolution is quite sufficient.  We recommend 
selecting the size that gives waveforms of a screen size nearest to your requirements, 
and then stretch the window to the exact size. 

Histogram Window 
The histogram window displays colour histograms provided a detailed and accurate 
method of assessing colour gamut.  Unlike traditional displays that indicate a signal is out 
of gamut, but little else, the colour histograms provide a great deal of information as to 
how out of gamut the signal actually is. 



     Page 41

 
The histogram window, like the waveform window, contains a section of controls which 
can be displayed or hidden on the right hand side of the window.  Please see the above 
section on the Waveform window for details of revealing the window controls.  Again like 
the waveform window, the most commonly used controls are available from the Colour 
Mode menu. 

Like with the waveform window, the top control in the right hand bar is the most 
important, and controls the format of the histograms  The available modes are 

YCbCr  Histograms are generated in YCbCr space 

YCbCr (SD) As above but after conversion to true SD levels 

RGB  Histograms are generated in RGB space 

Composite  Histograms are generated in Composite colour space. 

In each of the four modes, check boxes appear so that a subset of the items can be 
displayed if required.  Items may be displayed stacked vertically above each other (as 
shown here) or in parade form. 

The X position and X magnification sliders may be used to zoom in on a portion of the 
waveform.  It is also possible to enter numbers for position and gain into the boxes, or 
click on the x2, x4 etc buttons. 

The vertical range sets the scale of the graph, and can be adjusted to suit your exact 
data, but clicking the Auto button will produce a suitable scale very easily.  For most data, 
the best results will be obtained by clicking the ‘Log’ button, which applies a logarithmic 
scaling to the vertical axis (before pressing the Auto button). 

From the Options menu, you can open the Look and Feel configuration dialogue, in 
exactly the same fashion as for the waveform window.  This lets you specify the colour 
for each different possible Histogram element, including the Graticule and the cursor. 

Vectorscope Window 
The vectorscope window, like the waveforms and the histograms, has a section of 
controls that can be revealed and hidden.  However all of these controls for the 
vectorscope are automatically adjusted as the region of interest is changed.  Accordingly 
these controls will only be required very occasionally. 



     Page 42

 

The Look and Feel controls adjust the filtering controls applied to the module creating the 
vectorscope display.  The Gain control affects the brightness of the vectorscope image, 
whilst the Gamma of the display can also be varied.  Finally the length of the persistence 
on the display can be adjusted with the Decay control. 

Other important controls are available on the menu bar of the window. 

 
The Graticule controls let you change between a 100% graticule and a 75% graticule, or 
to hide the graticule, or separately hide the graticule labels. 

The Look and feel selection opens the common dialogue used to separately specify the 
colour of the graticule and the colour of the data.  You can also enable CRT emulation. 



     Page 43

‘Save snapshot’ will take the current vectorscope data and write it to a named bitmap file. 

On the Window menu are controls to resize the vectorscope display to match the 
resolution in which it is being generated.  These work in a similar fashion to these 
controls on the waveform window. 

Region of Interest Window 
The Region of Interest window controls some of the less required function, as most of the 
controls can be achieved by other means.  Alternative ways of control will be described 
along with the functions on this window.  These controls are global in that they affect the 
portion of the video image that is used to create the waveforms, the vectorscope, and the 
histograms.  Note that the dataview display is unaffected by these controls, as it always 
shows the exact incoming data based around the current cursor position. 

 

 
The top control is the most important one, and lets you change the waveform view from 
all lines (multi), to single line, or to sweep mode.  This control is available by clicking on 

the line mode button  on the main toolbar. 

The horizontal and vertical controls let you narrow down the area of interest.   
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The default waveform position has pixel 1 at the left of the display, and the last pixel on 
the right of the display.  It is possible to scroll the view of the waveform around, which 
provides a useful means of examining blanking data.  This can be done with the ‘H pos’ 
slider.  The image can be magnified using the ‘H mag’ slider, or numeric data entry, or by 
clicking on the ‘x10’, ‘x5’ or ‘x2’ boxes. 

You can select a single line or two line display with the ‘1L’ or ‘2L’ boxes.  You may need 
to select the single line mode in conjunction with these controls, depending on exactly 
what you want to see displayed. 

Similarly, it is possible to select only a given vertical portion of the video image to create 
waveforms, using the ‘Ypos’ and ‘Y range’ controls. 

The AV and FV buttons switch the waveform display between being restricted to just the 
active portion (AV), or the full raster (FV).  These two buttons will only be visible in certain 
display modes. 

There is another way of selecting a specific portion of the image for waveform generation.  
By right click and dragging with the mouse over the mini-pic, in either the windows view, 
or the full screen view, you can define an area.  This defined area will be used for the 
waveforms, the vectorscope and the histograms.  The magnification controls are 
automatically adjusted for the best display.   

Having defined an area, you can move the area about over the video by clicking and 
dragging with the middle mouse button.  Finally, double clicking over anywhere in the 
mini-pic, with the right mouse button, will revert to a full view over the entire frame. 

The ‘Sync data-view to ROI’ control means that when you define a region of interest on 
the mini-pic, the data view jumps to display the centre line within the defined region.  If 
this control is cleared, the dataview continues to show the values for the original area, 
which may be outside of the defined region. 

It is possible to click and drag to create a custom Safe Title (see Cage Generator on 
page 46).  By selecting ‘Sync cage safe-title to ROI’ the area defined in the Region of 
Interest is automatically applied as the area used for a custom safe title. 

Mini-Pic Window 

 
The mini-pic window has some important options available on its menus. 

The Pulse/cross mode delays the video by half a frame both horizontally and vertically, to 
emulate the HV delay mode of CRTs.  This may permit a clearer view of data adjacent to 
blanking.  This mode may be more useful if the ‘TRS Pass’ mode is also enabled, from 
the Analyzer menu of the main application. 
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The display of the mini-pic defaults to normal, full colour mode.  When using the XR in a 
colorist environment, where brightly coloured displays can be a distraction for the colorist, 
it may be helpful to switch the mini-pic into the monochrome mode. 

The mini-pic can also be switched into a blue or green mode, whereby the blue (or green) 
data is applied to all three channels.  This can be very helpful in looking for noise, or 
perhaps for looking for macroblocks, which tend to be more pronounced in the chroma 
channels over the luma channels, especially in HD. 

Show Closed captions is only useful if the incoming material (or test sequence) contains 
closed caption source, and if the correct source has been selected, which is also done 
from the Analyzer menu of the main application. 

The aspect ratio of the mini-pic can be changed from its default settings to preset values, 
or to a custom value, or may be forced to follow the Wide Screen Signaling values that 
can be contained within PAL video. 

The display of the crosshair on the mini-pic window can be enabled or disabled. 

Active tooltips shows the mouse position in pixel sample number, and video line.  For 
interlaced video formats, the line number will be displayed based on the field selection 
that has been made on the Crosshair toolbar, as described on page 33. 

The Look & Feel brings up the common Look and Feel dialogue, directly onto the mini-pic 
settings page.  You can select the colour of the crosshair, and independently the colour 
of the cursor. 

Lastly, you can save a snapshot of the currently displayed image.  This is saved as a 
.BMP file. 

Window Controls 
The waveform window, the vectorscope window, the data view window, the audio meters 
window, and the mini-pic window all have drop down menus to configure how the window 
contents are displayed, or the window manipulated.  Not all windows have exactly the 
same controls, but the following section should cover all of the available features. 

The windows all have an ‘Option’ menu.  Depending on window, this will have the 
following selections. 

Data  Change from RGB to GBR format. 

Graticule Enable the display of graticule 
Show graticule labels 
Specify graticule as SMPTE range, or full range. 
Choose graticule as 75% or 100%, for vectorscope 

  Choose calibration for different PPM scales, for audio levels 

Crosshair Show crosshair 
 

Aspect ratio Choose aspect ratio for mini-pic as one of a selection of standards, or 
choose custom aspect ratio 

Show Tooltips Gives line and sample number of point under cursor. 
 

The windows also all have a ‘Window’ menu.  This provides the following possibilities. 

Full Screen Select this and the chosen window data will be displayed in a full screen 
mode, without any windows artefacts present, such as toolbars, menus 
etc.  Press Escape to return to the standard display. 

Resize Select this to change the window size to the default minimum size to suit 
the data being displayed. 

Snap If this choice is enabled, windows snap to points on a grid as you move 
them around, which sometimes makes it easier to line them up as you 
require. 

Stretch By default as windows are resized, the data remains the same, with the 
extra space padded with black.  By selecting this option, the data 
contents are stretched to full the window, although still maintaining the 
original aspect ratio. 
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Cage Generator  

OmniTek XR contains a cage generator. By selecting the cage icon  the Cage 
dialogue appears.  

To enable the display of a cage, press ‘Enable Cage’. To enable masks, select a mask 
type from the drop down box. The mask will only be shown if Enable Cage is selected.  

The OmniTek hardware contains two separate cage generators, one for safe action, and 
one for safe title. Either can be used in the fixed or adjustable mode.  

 

If you are displaying both safe area and title together, it may be desirable to make the 
safe title lines dashed, using the check box, so that you may distinguish the two.  

It is possible to have the size and position of the safe area box shown on the main 
outputs, again by checking the relevant box.  

The masks key out the video in the selected area, replacing it with black. Masks may be 
enabled either inside or outside of the safe area or safe title boxes. The video that is 
masked out is also removed from the error-checking module, so the masks can be used 
to reduce the area where errors are flagged. Alternatively, by pressing the 'Video' button, 
the keyed out area is replaced with the currently selected image or sequence in the 
Generator window (if Motion/Capture options are present). 

The safe title box may be positioned by adjusting the X and Y values. However, it may be 
more easily positioned by clicking the Edit button. You can then click and drag over a 
representation of the current image. The box position can be fine tuned using the X & Y 
boxes afterwards. The settings can be saved. Click the Save icon to the right of the 
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'Profile' box. If there is a name shown in the profile box, then your settings will be saved 
to this 'file'. If it is blank, a dialogue box appears to let you enter a new name. Once you 
have several names in use, they can be selected by using the drop down arrow to the 
right of the profile box. Hence if you have several settings that you regularly use, these 
can be stored and recalled, without having to re-enter them. Note that these settings are 
saved into the registry, not as actual files on disk.  

Whilst you are using the 'Edit' feature, the main mini-pic will be turned off.  This is 
because the Edit dialogue is using the same mini-pic element to create the image.  

The safe title box may be positioned by adjusting the X and Y values. However, it may be 
more easily positioned by clicking the Edit button. You can then click and drag over a 
representation of the current image. The box position can be fine tuned using the X & Y 
boxes afterwards.  

It is also possible to save custom settings as ‘profiles’.  Once the Profiles box is open, 
click ‘Edit Profile’ to create a new profile, which is stored automatically.  You can then 
select from numerous named profiles. 
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5 Video Checking Features  
Introduction  

OmniTek XR has the ability to display real-time status information for audio and video 
data, and to detect and count various types of errors.   Status information and error 
counts are displayed in two status windows, one for video and one for audio. 

Video Status/Error detection 

 
The Video status box has two main modes of operation.  This is Report View, and normal 
view.  In report view, there are no buttons on the Video Status window, so it only reports 
information.  In the normal view, there are reset buttons for all error counters, error mode 
buttons, and alarm enable buttons, together with a global reset, global error mode and 
global alarm enable mode.  Selecting ‘Report View’ from the Options menu toggles 
between these two modes. 

The Reset error count menu selection lets you reset all counters, or specific ones as 
required. 

The number of errors since the error counters were last reset is displayed in the video 
status box. For each error condition, there are various display modes available. You can 
cycle through the available options by repeatedly pressing the mode button.  Note that 
the mode button looks slightly different depending on the current mode.  This function is 
duplicated by the ‘Toggle error count states’ menu selection. 

Display modes are -  

 Show the total number of errors. The number will be displayed in green whilst the count is 
0, and be red if there are errors.  

 Display the word 'Error' in red text for 0.5 seconds after an error is detected, then revert 
to showing 'OK' in green text.  

 Display the elapsed time since the last error. The text will be green if the error count is 0, 
and red otherwise.  

 Display the number of errors detected per unit of time. The unit used for time will vary 
depend on the actual error rate.  

Clicking the red  resets the individual error count. Alternatively, you may click the red  
at the very bottom of the window to reset all error counters.  
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The following information is displayed in the Video Status box  

General video status parameters 

• Input standard - Shows what standard has been detected (if in auto input detect), or shows the 
standard that the unit has been set to (if standard has been manually set). 

 
• Serial digital input - present & in correct standard, present but in an incorrect standard or missing  

 

The colour of the text of the status message, as well as the text are used to provide status 
information.  The messages have the following meanings. 

  Serial input is good, and is being used as lock reference. 

  Serial input is good, but is not being used as lock reference. 

 

 Serial input is not connected, and is being used as lock reference. 

 Serial input is not connected, and is not being used as lock reference. 

 

 ‘Serial input is connected, and is trying to use as lock reference, but is failing –  

perhaps because it does not match the current standard.   

 Serial input is connected, but is either bad, or does not match the current  

standard.  The serial input is not being used as lock reference. 

 
• Picture motion - moving/frozen 
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• The warning message can occur instantly, or after the condition has occurred for greater than a set 
period.  This can be adjusted in the Picture section of the Engineering dialog. 

 
• Luminance content - present/chroma only 
• The warning message can occur instantly, or after the condition has occurred for greater than a set 

period.  This can be adjusted in the Picture section of the Engineering dialog. 
 
• Chroma content - present/monochrome 
• The warning message can occur instantly, or after the condition has occurred for greater than a set 

period.  This can be adjusted in the Picture section of the Engineering dialog. 
 
• Analogue reference sync - present & in correct standard/present but in an incorrect standard/missing. 
 

The analog reference uses text in two colours to indicate status in the same way as for the serial 
input. 

Video Index parameters 

• Active format - not present or description of actual format 
• Coded frame - not present or description of actual format 
• Component set - not present or description of actual format 
• Sample structure - not present or description of actual format 

 

Wide screen signaling parameters (SD only) 

• Aspect Ratio - not present or description of actual format 
• Enhanced services - not present or description of actual format 
• Subtitles - not present or description of actual format 
• Others - not present or description of actual format 
 

Teletext Detection (SD only) 

• Teletext information - present/not present 
 

Closed Caption detection 

• Closed Caption (ANC 608) - present/not present 
• Closed Caption (ANC 708) - present/not present 

 

Error Checking parameters 

• CRC Check - Checks for valid CRC (EDH in SD).  Counts number of errors since last reset. View 
calculates a new CRC value from the incoming data, and compares this value with the CRC value 
embedded in the data. If there is a difference, View will flag this as an error. 

• Gamut check - checks the YUV data to see that it would be valid if converted into RGB space.  The 
RGB valid range is programmable at both minimum and maximum thresholds.   Counts number of 
errors since last reset. The range of valid values is set on the Video Engineering menu. 

• Range check - checks the YUV data to ensure that it falls within the valid part of the range. For each 
of Y, U and V, there are programmable minimum and maximum thresholds. Counts number of errors 
since last reset. The range of valid values is set on the Video Engineering menu. 

• TRS check - Checks for valid TRS data. Counts number of errors since last reset. 
• ANC check - checks for valid checksums on the ancillary data. Counts number of errors since last 

reset. 
• LIN check - (HD only) checks that the line number specified in the TRS packet agrees with the line 

number calculated internally.  Line numbers are not included in TRS packets in SD. 
 
All parameters in the Error Checking section have a simple line graph which shows the status of each 
parameter over the last few seconds.  This is a thin line displayed under the error counter display.  After 
resetting the error counter, the line is fully black.  As time passes with no errors, the line is gradually 



     Page 51

turned green.  Periods of time when errors occurred are coloured red.  Hence by looking at this line, you 
can see whether errors are in bursts, or periodic, etc. 
 

Timecode Checking 

The View module can check timecode on the serial input.  The reader is configured using the Time Code 
page of the Engineering dialogue box, described on page 23 of this manual. 

Where timecode is present, it is displayed at the bottom of the Video Status window, under the error 
checking lines.  In SD it is possible to display VITC and ATC.  Only ATC is available in HD. 

As well as displaying timecode values, OmniTek XR monitors the timecode to ensure that it increments 
correctly from frame to frame.  Each time that a timecode value is duplicated in adjacent frames, or is 
discontinuous from frame to frame, it is counted, and these count values are displayed in the Video 
Status window.  There are separate counters for VITC and ATC. 

ATC is a timecode packet, and can be loaded with LTC, VITC 1, or VITC 2.  The choice of timecode type 
is set in the Timecode section of the Engineering dialog. 

VITC detection parameters. (Vertical Interval timecode) (SD only) 

• VITC stuck frames.  Counts number of stuck frames since last reset.  (Looks for timecode not 
incrementing) 

• VITC skipped frames. Counts number of frames skipped since last reset.  (Looks at the timecode, 
and detects whenever a timecode value is missed) 

• Actual display of incoming VITC timecode, or detection if timecode not present, or if corrupt. 

ATC detection parameters. (Ancilliary data timecode) 

• ATC stuck frames.  Counts number of stuck frames since last reset.  (Looks for timecode not 
incrementing) 

• ATC skipped frames. Counts number of frames skipped since last reset.  (Looks at the timecode, and 
detects whenever a timecode value is missed) 

• Actual display of incoming ATC timecode, or detection if timecode not present, or if corrupt. 



     Page 52

6 Audio Checking Features  
OmniTek XR monitors PPM levels of 8 of the total 16 channels of audio, and channel 
status information for all 16 channels, displaying the results in the Audio Status window. 

 

For each audio group, XR firstly detects whether the group is enabled or not.  If it is enabled, then 
the status information is display.  If it is not enabled, none of the following will be present. 

 
• Audio usage - Professional/Consumer 
• Audio Sample - Audio/Data 
• Audio Emphasis - None/50/15ms/CCITT J.17/Unknown 
• Lock status - Locked/Unlocked 
• sample frequency - detection of audio sample frequency, which is one of 32 kHz, 44.1 

kHz, 48 kHz, or unknown 
• Channel mode - Dual/Single/ "Primary/Secondary"/Stereo/Unknown 
• Word length  - default/16 bits/18 bits/19 bits/20 bits/22 bits/23 bits/24 bits/user/unknown 
• Channel status - for each individual channel out of 16, we detect whether there is data 

present or not.  If present, we detect if valid or not.  If valid, we detect if the audio has 
exceeded programmable maximum or minimum thresholds.  On the GUI, the channel 
status is indicated by colour coding. 

 
Finally the audio levels are monitored and displayed.  The audio levels are compared in real time 
to the thresholds configured in the Engineering settings (see page 22 for details), and if any of the 
monitored channels exceeds the peak level, or reaches the silence level, a red box appears over 
the ppm display, showing either ‘Silence’ or ‘Peak’.   

 
Please note that the Motion/Capture option for XR does not generate audio signals. 
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7 Generator Window 
With the Motion/Capture option, the product has a Generator window, providing access to 
those functions required for saving and loading data.  The contents and operation of this 
window is described here.   

 
 

File Menu 
This lets you load and save configurations, where a configuration is a set of images and 
sequences.  Note that you cannot use these choices to load individual images, as this is 
done from the Source menu. 

This menu also lets you specify your Preferences for file loading. 

Every time an image is loaded, its size is compared with the current video format.  If it 
exactly matches, the image is loaded.  If not, then the ‘Default pattern fit type’ is 
considered.  This lets you specify a default action to take when loading images.  One 
default action is to always pop up a dialogue box asking for a resize choice.  The other 
options specify a default resize choice that the application will follow. 

‘Load patterns once they are imported’ lets you control actions within a Gen 
configuration.  When a configuration is loaded, a series of files are loaded into the control 
window.  If this box is ticked, the actual video data is also loaded into the OmniTek card 
video memory.  This would be the normal option to choose.  However if you frequently 
wish to change configurations, and only use an occasional image or sequence from each 
configuration, then it may be quicker to clear this box, in which case no images are 
loaded with the configuration.  To then load just a single image or sequence, merely click 
on the thumbnail and it will immediately start to load. 

‘Re-load patterns once they have been saved’ is included to better cater for multiple file 
formats.  For example, if a frame of video is captured, it is held in the frame buffer in the 
native YUV format.  If you then save the image to disk as a .BMP image, the data has to 
be converted to RGB.  The YUV frame being displayed will no longer accurately 
represent the file that has been saved due to the conversion from YUV to RGB.  Ticking 
this box always forces the image to be reloaded.  In this example, the RGB file would be 
loaded, converted into YUV and displayed.  Although the image is back in YUV format, 
there would normally be significant changes to the colour information with respect to the 
original YUV image that was captured. 
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‘Rotate thumbnail frame’ refers to the thumbnail image that is displayed when a 
sequence is loaded.  By default just the first frame of the sequence is displayed.  By 
selecting this choice, the thumbnail changes from time to time to other frames within the 
sequence. 

 

View Menu 
The view menu controls aspects of how the window looks.  It lets you turn off the toolbar 
and the status line if not required, and lets you chose a size for the image thumbnails.  
You can open or close the Playlist window, or switch between the Thumnbail view as 
shown above, or a text based list view. 

Source Menu 
The source menu is where you can load a previously saved image/sequence, or enter 
grab mode to capture from the serial input.  Both of these functions are also available 
from icons on the toolbar, described later.  You can also specify a Monitor folder.  This is 
an area that can be continuously monitored for new files, with each new file being directly 
loaded once it appears. 

Pattern Menu 
The Pattern menu provides various options concerning how images and sequences are 
manipulated.  Here you will find options to sort the images in various ways, or to save 
captured images, or to delete images from the configuration (but observe that this does 
not delete the image from disk).  This is described in more detail on page 56. 

Window Menu 
The Window menu only has the option to enable/disable ‘snap to grid’ when moving the 
window around. 

Toolbar Icons 

 
The generator toolbar icons have the following functions. 

  New configuration 
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  Open existing configuration 

  Save configuration 

 

  Import existing image or sequence 

  Capture data from serial input 

 

  Delete image or sequence from current configuration 

  Save current image or sequence to disk 

 

 Halt the import of patterns – useful if you start loading a sequence, then decide it is the 
wrong one. 

 

 Reload a selected image or sequence – if, for example loading was halted before it could 
complete 

 Reload all images and sequences. 

 

 Start file monitoring (only available if folder specified – see next icon). 

 Configure the file monitoring function – See page 60 for details 

 

  Enlarge the size of the thumbnail images (several sizes available) 

  Reduce the size of the thumbnail images 

  Toggle between thumbnail view and text view. 

  Open/close the playlist window.  See page 61 for details on this function. 

 

At the bottom of the Generator window there is a simple status display that displays the 
total memory available to store images, plus the amount that is used, along with a bar that 
gives a graphical indication of how much memory is used. 

The numbers used are calibrated in frames, and hence will change depending on the 
current video standard. 

If the Advanced module is present, then two sets of numbers are used, separated by a 
‘slash’.  The number before the slash is the number of frames if the frames are video only, 
and the number after the slash is the number if the frames are video plus all blanking data 
– ie frames in the OmniTek RVF format. 
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Pattern Creation 
Test patterns with the Motion/Capture option are one of two types – frames, and 
sequences. 

Frame based patterns 
These are stored as individual frames, so that a picture captured with a digital camera, or 
an image generated in a graphics application could be used.  Images can be in a variety 
of standard image formats, (jpg, jpeg, gif, yuv, yuv10, bmp, dpx and cineon).   

How to import Frame patterns 
Selecting Import Image brings up the file selector dialogue box.  Simply navigate to find 
files in one of the acceptable formats, select it, and click open.  The image is then 
imported into the display window, and a subsequent single click will transfer it to the 
output. 

Sequences 
These are sequences of frame patterns.  These are intended to be a sequence of 
adjacent frames captured from a video source.  Once a sequence has been loaded into 
OmniTek XR, it can be replayed forwards or backwards, in real time or faster or slower, in 
a loop, as well as stepping through the clip frame by frame.  Depending on standard, it is 
possible to play up to around 40 seconds of standard definition video. 

Please note that XR is a frame-based product.  This means that some field-based formats 
will sometimes give incorrect results.  For example, if you play a field based sequence 
forwards, it will play correctly.  However, if you play it backwards, the field sequence will 
not change, so the fields will play in the wrong order. 

Similarly the image resizing is done on a frame basis.  Hence if the images in a sequence 
consist of field images, and the sequence is resized on loading, then result may not be 
exactly as anticipated. 

How to import Sequences 
XR can load two main sequence types.  The main approach is to load a .avi file. Note that 
.avi files can only be loaded if the relevant avi codec is installed into the Windows 
operating system.  Codecs for common avi file formats are included in the standard 
Microsoft Windows installation.   

It is also possible to load a sequence consisting of individual frames, as detailed below.  
There isn’t a separate menu selection for loading sequences, as importing a sequence of 
frames is fundamentally the same operation as importing a single frame. Use the Import 
Image menu to bring up the file selector box.  Instead of selecting a single frame, select 
multiple frames (use of the shift key when selecting with the left mouse button, will help 
here).  Select OK, and the sequence will now load into memory. 

For the frames to be recognised as a sequence, the file naming must obey the following 
rules. 

Each filename must contain a fixed length number, so ensure that the smaller numbers 
are padded to the same number of digits as the largest number.  The number can be 
anywhere within the filename, as long as the position of the number within the file name 
does not change.  The number must increment contiguously. 

The frames used can be any image types that XR accepts for single frame images. 

Example of incorrect filenames. 

Test_7, Test_8, Test_9, Test_10, Test_11, Test_12 – The digits are not of fixed length.  
Test_7, 8 and 9 need to be renamed as Test_07, 08, 09 etc. 

Fred_08, Fred_09, Fred_11, Fred_12 – the numbers do not increment contiguously – file 
Fred_10 is missing, so the sequence will not load. 

Tmp_02, 03_Tmp, Tmp_04, Tmp_05 – the position of the digits varies. 
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Once the sequence has been accessed, the first frame of the sequence will appear in the 
XR window.  To actually load it into the output buffer, click on the image.  Once the 
sequence has loaded, the transport control icons in the main XR window can be used.  
The transport controls are described on page 27. 

Note that a long sequence, and in particular a long sequence of high resolution frames, 
will be slow to load. 

Having loaded a sequence, you may use the ‘Save As’ option (right click on the image) to 
save it.  XR supports saving sequences as .avi files, or as sequences of individual 
frames.  Note that saving .avi files over the network is not supported.  They can only be 
saved to the local drive.  In conjunction with the Advanced option, it is possible to save 
captured frames in RVF format. 

How to Grab Images (Motion/Capture option only) 
From the pattern menu, select ‘New Input’.  The following dialogue box appears. 

 
Three modes of grabbing are support, plus you can (optionally) select to either just grab 
the active video portion of the serial input, or to grab the entire data stream, including 
blanking, embedded audio, and ancillary data.  This latter choice is made by clicking on 
the 'full frame' box at the top of this dialogue, and is only available if you have the 
Advanced option.  More information is provided below. 

Single – just grabs a single frame.  Each time ‘Grab’ is pressed, a new single image is 
grabbed, over writing the image previously grabbed. 

Repeated Frames – Grab between 1 and 10 frames per time.  If you select 3, then you 
can press Grab three times, and each time an image will be grabbed. 
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Sequence - Select a length for the sequence (the maximum length will be determined by 
the standard you are in, and the mount of RAM fitted on your system).  When you press 
Grab, the unit starts recording a sequence of images, of the duration previously set.  This 
sequence may later be saved as a .avi file.   
 
If you also have the Advanced Option on your system, you can select the "Record Full 
Frame", so that image/sequence grabs also grab the ancillary data, including embedded 
audio, and timecode data, closed caption data etc, and all of this data will be stored along 
with the image data.  If this control is not checked, then only the active portion of the 
video is grabbed.  See below for more detail on full frame images. 
 
When you have finished grabbing your image(s), select ‘Done’.  You will be returned to 
the standard OmniTek desktop, with your grabbed images loaded into the Generator 
window.  Any images you wish to retain will need to be saved.  This can be done by right 
clicking on an image/sequence, and selecting ‘Save As’, in the usual fashion. 

 

Full Frame Record/Playback (Advanced Option only) 
The Advanced Option for XR provides the new ability to record or playback video, 
including the full video raster, such that all embedded audio, ancillary data etc, is 
captured with the video data.  

Images and sequences grabbed as full raster may only be saved to disk in *.rvf (raster 
video file) format, and are saved in the usual way.  Sequences are saved as multiple rvf 
files, all saved to the specified directory, with an incrementing number appended to the 
base file name that you specify.  To load a rvf sequence for playback, simple select 
multiple rvf files with a contiguous, incrementing number in the filename. 

The rvf file format is an OmniTek file format that contains a header, followed by the raw 
data from the serial bitstream.  No processing is done on the video before it is stored, so 
the original colour space is preserved intact.  Details on the file format will be made 
available to any interested parties. 

The video data is not compressed in any way.  This means that the RAM on the OmniTek 
card will hold fewer frames of rvf video as opposed to standard video.  On the status line 
of the application, the number of free frames and number of frames used has been 
updated to contain two sets of numbers, separated by a '/' character.  One number shows 
the number of frames in rvf format, whilst the other number shows the number of frames 
for standard video frames. 

Important Note 

When playing rvf files, it is important to note that some of the video insertion modes are 
not compatible with the full raster playout.  For example, if a clip is grabbed, including the 
embedded audio, video index information, VITC etc, then when the clip is replayed, you 
probably want this embedded data to be replayed with the video.  In this case, it is not 
possible to use XR to insert audio tones, or VITC etc onto the serial output.  In case you 
wish to overwrite the grabbed embedded data with values that are inserted by XR, we 
have provided a control on the Generator page of the Video setup dialogue, which is part 
of the Engineering controls for the main OmniTek application. 
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Under 'Use blanking and ancillary data', select 'from internal generator', to have the audio, 
video index, wide screen signalling facilities in XR available to insert data onto the output, 
and remove the entire ancillary data packets from the original source material. 

Alternatively select 'From Source Image (RVF), to use the actual data from the source 
image, in which case all of the Gen embedded data facilities will be disabled, for all full 
frame images.  However, they will continue to work in this mode for all video images and 
sequences that only contain the active video portion of the raster. 

 

RVF File Editor (Advanced Option only) 
The Advanced Option also includes a separate Windows application to let you view and 
edit the rvf files.  This application can be run concurrently with any other OmniTek 
application.  The initial release of this application lets you open files, and check the status 
of various of the ancillary data, and lets you edit the hex data anywhere within the file. 

 

Pattern Menu 
This menu lets you control various aspects of manipulating patterns. 

Under Sort you have the choice of listing the loaded patterns in different 
ways. 

Load loads the selected image into Gen SDRAM, and Load All loads all 
images into the SDRAM.  This is useful if you have disable automatic 
loading of images, which may be done in the Preferences menu choice, 
from the File menu. 
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Specify load sub-section is concerned with sequence loading (part of Motion/Capture).  
This item is only available if the currently selected thumbnail is a sequence.  This menu 
selection opens a dialog that lets you specify a different frame as the first in the 
sequence, other than frame one which is the default.  Similarly you can specify a final 
frame number as something less than the normal last frame.  This is particularly useful 
with avi files which may contain more frames than the Gen frame buffer can hold.  
Without using this option, it is not possible to access frames at the end of the avi file. 

Resize Output provides some options as to how images are resized when the image is 
not the same size as the currently selected resolution.  The choices are the same as 
available from the Preferences menu choice, described on page 54. 

Edit brings up an editor for line patterns, or zone plates. 

Save lets you save the current image, and is intended for use with an image that has 
been grabbed from the live input. 

Save As… lets you save the current image to a new filename, and/or in a new format.  
For example, an image loaded as a BMP could be saved as a JPEG, or a sequence of 
multiple individual frames can be saved as an AVI file.  Please note that when an image is 
saved, it is automatically reloaded afterwards.  This is in case the image format has 
changed, such as from BMP to JPEG, so you can immediately see that the new image 
format is suitable. 

Save Frame As… is a mode used with sequences, and lets you save an individual frame 
from anywhere within the sequence. 

Properties provides information about the current image. 

Delete removes the selected image from the Gen window, and frees up the SDRAM that 
was occupied.  It does not affect the image that is stored on disk. 

File Monitor Function 
XR has a file monitor function, also part of the Motion/Capture option.  Once configured, 
XR will constantly look at the contents of specified folders, and as files appear, 
automatically load them. 
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To configure the file monitor, click ‘Add’ to choose the location for the monitored folder(s).  
Specify which file format(s) to monitor by ticking the appropriate boxes.  The actual 
monitoring process can be enabled by either clicking the ‘Monitor’ button on this dialogue, 

or by clicking the ‘start monitoring’ icon, . 

This function is very useful in conjunction with remote processes that are rendering 
images to create clips.  The images that are created can be loaded into the XR unit as 
they appear, and compiled into a moving sequence, or checked out using the various 
waveform monitoring functions that are part of XR. 

Generator Playlists 
An OmniTek XR system has the ability to create and manage playlists.  A playlist is, in 
effect a scheduled playout system that can run through a predetermined list of video 
images and clips, with each item in the list potentially having different audio settings, and 
with certain different video engineering settings, and each can be displayed for a different 
duration. 

The playlist can be opened and closed by clicking the ‘PL’ toolbar button, or the ‘Playlist 
Window’ menu entry found under the ‘View’ menu. You can think of the playlist Window 
as a sub-window of the Generator window, as the playlist window can only be open when 
the Generator window is open.    

The playlist is just like a sequence pattern, it can be played forward or backward, it can be 
stepped through, and you can go direct to a specific frame.  The playlist ‘pattern’ in the 
Generator Window must be selected like you would any other pattern, at which point you 
can traverse the playlist using the run toolbar as you would a normal sequence.  This 
playlist ‘pattern’ is the blank thumbnail in the Generator window with the word ‘Playlist’ 
written across it.  It is visible at all times and is always the first ‘pattern’ in the 
configuration.   Please remember that the playlist is software driven, so there will be some 
latency when switching patterns within the playlist, or, for example, when a playlist is 
stopped mid item, the software makes an estimate of the frame you have stopped at 
using a number of internal factors. 

The actual playlist is created by dragging a pattern from the Gen window into the playlist 
window.  An item from the Generator window can be dragged into the playlist as many 
times as required.  It is not possible to drag and drop using multiple selections.  Since 
drag and drop does not work with all PC configurations, it is also possible to right-click 
over an item in the Gen window, and select ‘Add to Playlist…’, to achieve the same effect. 

 

The playlist Window shows items as a row entry in a list.  Each entry has a thumbnail 
preview of the source pattern, the path and type of that pattern, and the duration in 
frames/seconds of that item.  A ‘selected’ item in the playlist for editing, is highlighted in 
black.  The currently ‘showing’ item is highlighted in red/pink, so it is the red/pink colour 
that indicates what item is currently being generated.   
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Add/Edit item 
As previously mentioned, items can be added to the playlist by dragging a source pattern 
from the Generator Window.  Upon doing so, an item-edit Window will appear allowing 
the user to specify the duration for this item and also the ability to edit various video/audio 
generator features such as panning, character generation, audio tones etc.  These 
video/audio generator settings will apply to the specified item only.  This allows the user 
to change, for example, audio channel tones for different items in the playlist. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The item properties/edit Window is displayed when a pattern is ‘drag and dropped’ from 
the Generator Window into the Playlist Window.  The Window can also be accessed for 
existing playlist items by double-clicking an item, using the ‘Selected pattern properties’ 
menu entry under the main ‘Pattern’ menu, by pressing enter, or by using the ‘Selected 
pattern properties’ toolbar button.  These actions only effect the selected item.  Use the 
‘Edit’ context menu entry also to edit an item (selected or otherwise).  The Window allows 
the user to specify in frames or seconds (for the current video-standard) how long the 
item should be displayed for.  For frame, line, and zoneplate patterns, this same frame 
will be played out for this duration.  But for sequences, the pattern will be played forwards 
or backwards in a loop for the entire duration.  The ‘Use Current’ button can be used to 
set the video/audio settings for the current engineering settings. 

The video/audio generator settings work in the same way as the normal video/audio 
generator settings found in the engineering Window. 

Source pattern path 
and thumbnail preview 

Duration for this item 
in frames and seconds 

Video/audio generator 
settings for this item 
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Item order 
Playlist items can be ordered (moved up and down the list) by using the up/down arrow 
toolbar buttons or the ‘Move selected pattern down’/’Move selected pattern up’ menu 
items in the ‘Pattern’ main menu.  These actions will only affect the selected item.  You 
can also move an item up or down the list by using the ‘Move up’ and ‘Move down’ 
context menu items; these will move any item up or down the list (selected or otherwise). 

Delete item 
To delete an item in the playlist use the cross toolbar button, the ‘Remove selected 
pattern’ menu item under the ‘Pattern’ main menu, or press the delete key.  These actions 
will only affect the selected item.  Use the context menu ‘Remove’ item to delete an item 
(selected or otherwise). 

Playlist save/open/new 
Playlists can be saved or opened using the ‘Save playlist’ or ‘Open playlist’ toolbar 
buttons or the ‘Save playlist’, ‘Save playlist as’ , and ‘Open Playlist’ menu items under the 
‘File’ main menu.  Use the ‘New playlist’ toolbar button or ‘New playlist’ menu item found 
under the ‘File’ main menu to create a new blank playlist.  Playlists are saved as .odp 
files.  The last used playlist will be opened automatically when OmniTek LAB starts up.   

Note that there is a very tight cohesion between the playlist and the Gen configuration.  
Since the playlist is only a set of ‘instances’ of patterns, the ‘source’ patterns have to be 
intact in the current configuration.  If a playlist item is not found in the current 
configuration an error message will be displayed. 

 

Important Notes: 

When a playlist is playing, the video and audio generator settings are changed to the 
ones specified for the current item.  If the user goes in to the normal engineering and 
changes the video/audio generator settings, these will not affect the current settings 
because the playlist is using its version of the settings for the current item.  Therefore the 
normal engineering settings will not have any effect until the playlist is exited. 
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There are a number of occasions where a playing playlist will be stopped: 

• An item is added, edited or deleted 
• The pattern in the Generator Window is changed 
• The order of the items in the playlist Window are changed 
• A new Generator configuration is  created, or a new configuration is loaded 
• A source pattern used in the playlist is deleted from the Generator configuration  
• A source pattern used in the playlist is loaded into SDRAM 
• A new playlist is created or a playlist is loaded 
• The video standard is changed. 
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8 Other Features 
Status Bar 

At the bottom of the main application window, there is a status bar. 

 
The currently selected video format is display. Note that this may not reflect the standard of a video 
source connected to the unit. 

The status of the analog reference, and the serial input are then displayed.  The items are colour coded to 
indicate status.  If the colour is orange/brown, then the item listed is incorrect in some fashion, but is not 
being used.  If the colour is red, then it is incorrect, and is being used.  If green, then it is OK. 

The current colour space mode for waveform display is also indicated.  This will be YUV or RGB parade, 
or YUV or RGB component.  This choice is independent of the format of the serial video data. 

The waveform mode is indicated.  This can be All line, single line, or frame view. 

Finally the current selection from the four available work surfaces is indicated. 

At the very right hand is a little field interrupt indicator.  This spins during normal operation, indicating field 
interrupts are being processed.  It will stop during certain operations, such as loading files from disk. 

 

Miscellaneous Features  
OmniTek XR contains a variety of minor features all designed to make the product more 
useful and easy to use. Some of these are described here.  

Window sizes  
The size of all of the windows is related to the video standard. If you position and size the 
windows in a given standard, then they may well be too small or too large in the new 
standard. If you right click on many of the windows, then a menu appears with a resize to 
fit option. Select this, and the window will become the minimum size to suit the data being 
displayed. 

 

Size and Position Snap  
By default, windows will be set to ‘jump’ if they are sized or moved. This works as if the 
windows are magnetic, so a window placed near another one will jump to line up with the 
edge of the other window. This is not a jump to grid function. This mode of operation can 
be confusing sometimes, and if you wish to position a window adjacent to two others, it 
may be necessary to move one away whilst the move is taking place, and to put it back 
afterwards. By right clicking on a window, you get an option to disable this magnetic 
jumping function, so that windows can be moved to any position, regardless of what is 
nearby. If you subsequently use the menu to enable the magnetic jumping feature, then 
this will only take effect next time you move/size the window – it won’t affect the current 
size and position.  

‘Shift’ Keyboard Shortcuts  
At any time you may press and hold the ‘Shift’ key. A small menu appears providing 
immediate access to some common functions. The menu disappears when either a 
function is activated, or the Shift key is released. Of particular use, Shift-E immediately 
opens the Engineering dialogue.  

The other particularly useful ‘Shift’ shortcut, is Shift-P, which opens the Presets 
configuration dialogue. 
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Presets 

 
Presets are individual macros that can be assigned to hotkeys.  Presets can be freely 
assigned to Shift-F1 through to Shift-F12.  Presets work in both the normal Windows 
environment, and in the full screen modes. 

To create a new preset, press the ‘Record’ button.  All actions that are performed are 
captured, right up until the Stop button on the Presets window is pressed.  (The Record 
button is replaced with a Stop button during Record mode). 

Once Stop is pressed, a dialogue appears to let you assign a name to the preset, as well 
as specify the authors name, and a description of the preset.  The description appears in 
the Preset window shown above. 

Once the preset is created, it should be assign to one of the twelve Shift-function keys, by 
pressing the ‘Hot-Keys’ button. 

Once a preset has been created, the essential control elements are distilled into a text 
file.  Selecting a given preset and pressing ‘Edit’ opens a text editor.  Although care 
needs to be adopted, it is possible to edit the text file, and save it back again. 

Presets are particularly useful for changing settings such as switching from single line to 
multi-line mode, and can be used independently of the assignable full screen modes, 
which are also assigned to hotkeys. 
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 A1 File Types 
Current OmniTek systems use some unique file types.  This section explains what type of data is held in 
each file type. 

.ods (OmniDesktop Settings) 
Stores everything: all user configurable engineering settings, the four layouts (pages), and all other misc 
settings and preferences.  Note that OmniTek saves a .ods file when it is closed down, and opens that 
same file when it next starts up, ensuring the system is in the exact same state in was last in (called 
'startup.ods' and is located in 'program files\omnitek\omnitek').  OmniTek allows the user to optionally load 
a .ods file at startup, make sure the 'At start-up prompt to load system configuration' option is checked in 
the File->Preferences menu. 
.ode (OmniDesktop Engineering) 
Stores all user configurable engineering settings (those settings configurable via the engineering 
Window). 
.odl (OmniDesktop Layout) 
Stores layout information for current page: child Window position, size, snap.  Z-order of child Windows.  
Toolbar visibility, position.  Layout name.  Line-data Window: visible sections for RGB/YPbPr colour 
modes.  Video-status Window: visible items. 
.ogs (OmniGen Setup) 
Stores the generator configuration:  default resize type, pattern path, resize type, and load status.  
Selected pattern.  List/thumbnail mode. 
.ini (Initialization) 
Generic data is stored in ini files.  OmniTek uses three .ini files, one for the full-screen-layout definitions 
(full_screen_layouts.ini), one for range-error profiles (analyzer_range_error_profiles.ini), and one for cage 
safe-title profiles (cage_safe_title_profiles.ini).  All of these ini files are stored at the same level as the 
OmniTek executable (usually at c:\program files\omnitek\omnitek). 
.xml (Extensible Markup Language) 
The main event log and the picture quality time-based log are stored/loaded as XML files. 
Generator patterns 
Extension Input Output Description 

    
bmp x x Bitmap 
jpg/jpeg x x JPEG 
tif x x TIF (Tagged Image File Format) 
gif x x GIF (Graphics Interchange Format) 
png x x PNG (Portable Network Graphics) 
yuv x x YUV 8 bit-per-pixel (8 (U), 8 (Y), 8 (V), 8 (Y)) 
yuv10 x x YUV 10 bit-per-pixel (10 (V), 10 (U), 10 (Y), 2 (padding)) 
dpx x  DPX (Digital Moving-Picture Exchange) 
cin x  Cineon 
rvf x x Raster Video Format, SINGLE-LINK ONLY, stores active video AND blanking 
raw x x Raw active video, DUAL-LINK ONLY, (V/R (10), U/B (10), Y/G (10), 2 (padding) 
lpd x x Line pattern 
zpd x x Zoneplate 
avi x x Microsoft Audio/Video Interleaved 
wmv x  Windows Media Video 
asf x  Microsoft Windows Media Advanced Systems Format 
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A2 Logging 
Configuring Logging, and SNMP alerts 
 

OmniView now contains a comprehensive logging package.  The system has the ability to make entries 
into an XML log file whenever specific conditions occur.  It can also transmit an SNMP alert based on 
certain conditions occurring.  These two functions work independently.  Both log entries, and SNMP 
alerts, can include VITC or ATC if present, and the current time. 

Logging Configuration and use 

Clicking on the   icon opens the Event log window, as shown below. 

 
The window shows ‘live’ logging as it happens.  The data is not written to a log file unless 
the green ‘Start’ button is pressed.  At this time, all log entries are written to a temporary 
file.  When ‘Stop’ is pressed, logging stops, and a dialog box opens to let the user choose 
a name for the log file. 

Each line in the Event Log window starts with one of three icons.  To reduce the number 
of entries, events are shown as starting on a given frame, and then being continuous for 
a period, and then stopping on a given frame, rather than each occurrence getting an 
individual entry.  So the three icons used have the following meanings. 

  The named event started and continued for every frame 

  The named event had been occurring on every frame, but stopped at this point. 

  The named event only occurred on this frame. 

 

Clicking on the  button opens the configuration dialog for logging.   
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Every parameter that can be logged is shown on this dialogue.  There is a check box 
adjacent to each parameter.  If the check box contains a solid ‘tick’, as shown above, 
then occurrences of the parameter is written into the XML log file, with the word ‘ERROR’ 
next to it.   

If the check box contains a grayed out tick, then occurrences of the parameter is written 
into the XML log file, with the word ‘WARNING’ next to it.   

If the check box is not ticked at all, then the associated parameter is not included in the 
XML log file. 

Each time you click in each check box, the state cycles from ‘log as ERROR’, to ‘log as 
WARNING’, to ‘not logged’, and then back to ERROR, and so on. 

Note that certain parameters only exist in SD. These are Wide screen signaling, Video 
Index, and VITC, so these selections are not available in HD.  The system supports two 
different specifications for Wide Screen Signalling, and only one specification is 
supported at a time.  To choose which specification, go to the Wide Screen Signalling 
section of the main Engineering dialog. 

It is possible to select VITC or ATC timecodes to be included in the log file.  VITC only 
exists for SD signal.  The ATC packet can be loaded with LTC, or VITC 1 or VITC 2.  The 
particular timecode type is set on the Timecode section of the main Engineering dialog. 

As well as always logging chosen parameters, you can use the “Timecode Triggers” 
section to only log between certain timecode values.  Use the ‘Add’ button to set these 
up. 
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SNMP Configuration and use 
The SNMP configuration dialog is accessed from the main Configuration menu. 

 
You can use this dialogue to specify which of the listed conditions should be used to send 
SNMP traps.  Each item will send a trap every time the specified error condition occurs, or 
clears.  For example, if Picture Quality is selected, the application will transmit an SNMP 
trap when the picture quality drops below the threshold, and again when the picture 
quality rises above the threshold.  This set of parameters is not filtered in anyway, so 
there are no timeouts affecting whether the parameters are sent.  In this way, a remote 
monitoring application will receive all the raw data, and the user can control and change 
their own filtering as required. 

When the OmniTek application starts up, it will always check to see if an SNMP service is 
running on the host PC.  The number of attempts to connect can be set here, as well as 
an option warning of connection fails. 

SNMP Configuration Problems. 
The SNMP service is an optional Windows component, and is not installed if a standard 
Windows installation was done.  OmniTek has produced a short document describing 
how to add the SNMP service onto a PC.  This document is called 'SNMP installation 
guide.pdf", and is available from our FTP site.  It is also available in the user manuals 
section of our website.  Visit www.omnitek.tv, then select 'support', and then click 'SNMP 
Installation Guide, for use with Quality Auditor'.  This document is also available on 
request from your dealer. 

 

When the SNMP service is running, note that by default, Windows will send SNMP traps 
only to the host machine - ie only to itself.  To send the traps to other machines, you need 
to configure the trap addresses.  This is done by opening the Control Panel, then 
selecting 'Administrative Tools', and then selecting 'Component Services'. 
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Select the 'Services (Local)' item in the left hand pane, and then scroll down to the 'SNMP 
Service' item in the right hand pane.  Double click the 'SNMP Service' item, and then go 
to the 'Traps' tab. 

 

You can now add, delete or edit the IP addresses where traps are sent.  You'll probably 
see a single entry in the 'Trap Destinations' list box, called 'localhost'.  'localhost' is the IP 
address of the 'local' machine, which means that traps are sent and received by the local 
machine, and do not go to other machines.  You can enter multiple IP addresses, so that 
the traps are sent to multiple machines. 

 

MIBs for OmniTek products may be downloaded from the Support section of the OmniTek 
website, www.omnitek.tv 
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A3 Measuring Audio/Video Delays 
An OmniTek system can be used to measure either absolute audio and video delays through external 
equipment, or can measure the relative delay between the audio and video paths.  The OmniTek modules 
and options required are different between the two modes.  The Advanced Option is required.  This 
appendix describes what OmniTek products are required for each mode, and how to configure the 
OmniTek system in each mode. 

 

Both measurement modes rely on the use of a special full-motion video test sequence which contains 
precise embedded audio tones. This sequence is available for all standard-definition and high-definition 
video formats, and may be played out either from an Gen signal generator (equipped with the Motion 
option) or simply from a videotape machine or video file server. 

The following sections describe the OmniTek delay test sequence, and show how it may be used to 
perform audio and video delay analysis on external equipment. 

A/V Delay Test Sequence 
 
OmniTek have generated a special full-motion video sequence, 192 frames in duration. This is available 
in all video formats, both standard- and high-definition. The test sequence contains many elements which 
are useful for testing and analysing the performance of a video system, however for the purposes of the 
audio/video delay measurement there are two characteristics which are of special importance: 

 
On the first frame of the sequence only, an embedded audio tone of 8kHz is generated on channel 1 at a 
level of –18dB(FS). 

 

In the top left-hand corner of each frame, a binary frame count is displayed as a sequence of yellow 
squares. 

 

In the View analysis software, the binary frame count can be extracted from the input video image, and 
the embedded audio tone is also detected. The relative timing of the audio tone to the first video frame in 
the sequence indicates the delay between audio and video components. 
 
 
 
 
 

 

 

 

 

 
 
 
 
 

When the clock hand reaches the top (frame 0),
an audio pulse is generated for 1 frame duration

This is a binary count of the 192-frame
sequence, 0x00 ~ 0xBF (hex)
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Loop A/V Delay Testing 
In this mode, the absolute video and audio delays are measured between the input and output of the 
OmniTek system. The A/V Delay Test Sequence is output using the Gen signal generator, and the signal 
is taken directly to the equipment under test. The output from the equipment is fed straight back to the 
View input. 

 
 
 
 
 
 
 
 
 
 
 
 
 
The View analysis software compares the timing of the output video and embedded audio with the input 
video/audio timing. The total propagation delay through the external equipment is calculated and 
displayed. 

 
 
 
 
 
 
 
 
 
 
The time delay range that the system is capable of measuring is: 

     50Hz Systems            60Hz Systems 

Audio delay:   0 ~ 7680 ms  0 ~ 6400 ms 

Video delay:   0 ~ 7680 ms  0 ~ 6400 ms. 

 
The time delay measurement for the audio may be displayed as samples (at 48kHz) or milliseconds. The 
video delay may be expressed as “Frames : Lines : Pixels” or milliseconds. In all cases, measurement 
accuracy is better than 1 ms. 

OmniTek System

OmniGen

OmniView

Equipment
Under
Test
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Relative A/V Delay Testing 
In this mode, the relative delay between audio and video is measured. The OmniTek A/V Delay Test 
Sequence generator may be installed remotely to the video analyzer, which means that it is possible to 
measure A/V delays in satellite, cable, or terrestrial broadcast links. 

 
 
 
 
 
 
 
 
 
 
 
Note that the delay test sequence may be played out from an Gen system, a videotape machine, or a 
video file server. 

 

In this mode, the View software analyses the input video signal, looking for the first frame in the sequence 
(identified by the binary code). When this is detected, an internal timer counts the time delay before the 
audio input pulse is detected. The system automatically detects whether the audio pulse is early or late 
with respect to the video, and displays the results accordingly. 

 
 
 
 
 
 
 
 
 
 
The delay range that the system is capable of measuring is: 

                50Hz Systems           60Hz Systems 

Audio early with respect to video:  0 ~ 5760 ms  0 ~ 4800 ms 

Video early with respect to audio:  0 ~ 1920 ms  0 ~ 1600 ms. 

 

The relative time delay measurement is always expressed in milliseconds, and the accuracy is better than 
1 ms. 

OmniViewOmniGen

Transmission Path
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Setting up the OmniTek System 
 

This section explains how to set up the OmniTek system to perform the delay testing operations. 

Gen Setup 
If Gen is to be used for generating the special A/V Delay Test Sequence, this is the sequence of 
operations required: 

1. Set the Gen system to the correct video format in the “Engineering > Video Setup > General” 
menu. 

2. Make sure no other images are loaded into the Gen desktop. 

3. Load the 192 frames of the special A/V Delay Test Sequence that is applicable to the current 
video format. Choose the “no fit” option if necessary. Then play the sequence in an endless loop, 
by using the icons on the transport toolbar. 

 
 
 
 

4. In the menu “Engineering > Audio Setup”, make sure that the audio tone on channel 1 is set for 
8kHz, -18dB, and present only on frame 1 of the sequence.  This setting is essential for correct 
operation. 
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View Setup 
Set the source routing such that the serial output from the OmniTek system is coming from the Gen test 
sequence, and the analyzer input is connected to the serial input. 

 
 
 
Enable the A/V Delay Measurement dialogue by selecting ‘Delay measurement…’ from the Analyzer 
menu.   

Select “Loop Delay” or “Relative Delay” on the dialogue box, to choose the measurement type to be 
performed. 

 
 
 
 
 
 
 
 
 
 
 
The audio and video delay values will be displayed on the dialogue box. Please note that the delay 
calculations are performed once for each loop around the 192-frame video sequence, therefore there is a 
latency of several seconds before new delay readings are displayed. 
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